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Робочий зошит для учня тренінгу з програмного забезпечення SMART Notebook для користувачів 
SMART Board рівень 1 
 

Початок роботи 
 
Як працює інтерактивна дошка  
SMART Board? 
 
Інтерактивна дошка SMART Board™ дуже проста у використанні. Якщо ви можете користуватися 
комп'ютером, то зможете користуватися і інтерактивною дошкою. 
 
Сенсорний дисплей з'єднується з вашим комп'ютером і проектором для показу зображення вашого 
комп'ютера. Ви можете управляти додатками з дисплею за допомогою пальців, писати нотатки 
цифровими чорнилами і зберігати вашу роботу для подальшого використання. 
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Початок роботи 
 

Як працює інтерактивна дошка SMART Board? 
 
Інтерактивна дошка SMART Board чутлива для дотику і працює як частина системи, що включає 
комп'ютер і проектор. 

 
 

 Комп'ютер надсилає зображення програми на проектор 

 Проектор передає зображення на інтерактивну дошку 

 Інтерактивна дошка діє одночасно як монітор і вхідний пристрій, надаючи вам можливість 
контролювати програму простим дотиком інтерактивної дошки 
 
Ви можете сприймати інтерактивну дошку так само, як вашу мишу або клавіатуру — це вхідний 
пристрій, що надає вам можливість управляти програмами на вашому комп'ютері. 

 
Поради з безпеки 
 Ви і ваші учні ніколи не повинні дивитися прямо на промінь світла з прожектора. Ви (і ваші учні) 
завжди повинні робити крок (або навіть два) в бік перед тим, як повернутися обличчям до класу.  

 Скажіть вашим учням, щоб вони не торкалися проектора, оскільки він може дуже нагріватися 
під час роботи. 

 Не використовуйте стілець для збільшення доступу учнів. Якщо ваші учні не можуть дістати до 
верхньої частини інтерактивної дошки, опустіть її. Можливо, вам доведеться перевісити встановлений 
на стіні пристрій у нижче положення. Якщо ваша інтерактивна дошка підвішена до стійки на підлозі, 
опустіть її за допомогою іншого дорослого. 

 Скажіть учням, щоб вони не бігали поблизу стійки на підлозі, оскільки вони можуть зачепитися 
через ніжки стійки. 
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Ваш палець — це ваша миша 

 
Ви можете управляти програмами на вашому комп'ютері з інтерактивної дошки. 
Натиснути пальцем на інтерактивну дошку SMART Board — це те саме, що 
натиснути на вашу мишу. Ви відкриваєте програму так само як робите це на вашому 
комп'ютері, але замість використання миші для вибору та відкриття файлів, просто 
натискаєте або двічі натискаєте на значок програми пальцем. 
Орієнтування інтерактивної дошки забезпечить, щоб курсор був відрегульований 
згідно вашого дотику пальцем.  
 

Полиця для ручки SMART 
 
Полиця для ручки SMART складається з чотирьох кольорових відсіків для ручок та одного відсіку для  
інструменту для стирання. Кожний відсік має оптичний сенсор для визначення, які інструменти з ручок 
та інструмент для стирання узяли. Ви можете писати ручкою або пальцем, якщо відсік для ручки 
пустий. Технологія у полиці для ручок досить розумна для того, щоб знати, який інструмент забрали з 
його відсіку останнім. Якщо ви приберете інструмент для стирання з його відсіку, поки все що тримаєте 
ручку, полиця вирішить, що ви хочете стерти. Індикатори над відсіками з інструментами показують, 
який інструмент було взято останнім. 
 

 
 

Кнопки полиці для ручок 
На полиці для ручок є принаймні дві кнопки. Одна кнопка використовується для запуску клавіатури на 
екрані. Друга кнопка використовується, щоб зробити ваш наступний дотик до інтерактивної дошки 
натисканням на праву клавішу. Деякі інтерактивні дошки мають і третю  кнопку. Третя кнопка 
використовується для швидкого доступу до Центру допомоги. 
 
      
 
 
 
 
 
 
                           Кнопки полиці для ручок 
 
 
 

Ручки 
Інтерактивна дошка SMART Board постачається з чотирма ручками: чорною, червоною, зеленою та 
синьою, а також одним інструментом для стирання. Хоча вам не обов'язково використовувати ці ручки 
для писання на інтерактивній дошці, вони роблять писання більш інтуїтивним. Візьміть ручку з полиці 
для ручок SMART і починайте писати. Для стирання вашого цифрового чорнила, заберіть інструмент 
для стирання з полиці для ручок і здійсніть плавний рух по ваших записах. Записи зникнуть.  
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Клавіатура на екрані  
 
Віртуальна клавіатура на екрані прибирає необхідність у приєднаній фізичній клавіатурі, оскільки ви 
можете використовувати її безліч виглядів, щоб набирати текст. Існує кілька можливих виглядів 
клавіатури, зокрема Класичний, Білий, Простий, Прості Заглавні, Цифрова клавіатура та Ярлики. 
 
Для відкриття клавіатури, натисніть значок SMART Board у ділянці повідомлень і оберіть Keyboard 
(клавіатура). Або натисніть кнопку Keyboard на полиці для ручок вашої інтерактивної дошки SMART 
Board.    
 
 
 
 
 
 
 
 

Надрукуйте або відредагуйте текст у будь-якій програмі, не відходячи від інтерактивної дошки. 
Натисніть кнопку Keyboard на полиці для ручок для запуску клавіатурі на екрані. 

 
Класичний вигляд 
Натисніть віртуальні клавіші для набору тексту, потім натисніть кнопку Send (надіслати), щоб помістити 
текст в активне діалогове вікно або програму. Ви можете надрукувати текст у будь-якій програмі, 
незалежно від того чи є воно Ink Aware, чи ні. 
 
 
 
 
 
 
Оберіть вигляд → 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ви можете використовувати 
клавіатуру для заповнення  
форм в Інтернеті або для  
введення тексту в будь-якій 
програмі. 
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Панель попереднього перегляду 
Натисніть кнопку з подвійною стрілкою, щоб відкрити панель попереднього перегляду. Коли панель 
попереднього перегляду відкрита, ви можете надрукувати слово або речення повністю перед тим, як 
надіслати будь-яку інформацію до програми. Коли ви завершили друкування, натисненням кнопки 
Send (надіслати) ви надішлете ваш текст до активної програми. 
 
     Панель попереднього перегляду Кнопка з подвійною стрілкою 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Простий вигляд 
Вчителі, які викладають учням, які тільки вивчають алфавіт, або ще не знайомі зі стандартним 
виглядом клавіатури, оцінять два простих вигляді з доступних — Простий (Simple) і Простий Великі 
літери (Simple Caps). В обох цих варіантах, літери розташовані в алфавітному порядку, за якими йдуть 
цифри від 0 до 9. 
 

 
 
 

Права кнопка миші 
Натисніть на кнопку правою кнопкою миші на полиці для ручок, щоб ваше  
наступне натиснення на екрані сприймалося як натиснення на праву кнопку.  
У нижньому правому кутку вашого екрану з'явиться малюнок з нагадуванням,  
що ваше наступне натиснення зареєструється як натиснення на праву кнопку.   
 
 
Порада: Замість натиснення на кнопку правою кнопкою миші, натисніть і тримайте на ділянці екрану, 
де ви б хотіли натиснути правою кнопкою. За кілька секунд натиснення та утримання ділянки з'явиться 
меню з правою кнопкою.  
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Орієнтування вашої інтерактивної дошки SMART Board 
Орієнтування забезпечує те, що коли ви використовуєте 
інтерактивну дошку, ваш дотик реєструється правильно.  
 
Якщо ви торкаєтеся значка, а ваш курсор з'являється не 
там, де ви натиснули, спробуйте  орієнтацію 
інтерактивної дошки. Після орієнтації ваш курсор 
повинен з'являтися там, де ви торкаєтеся до 
інтерактивної дошки.  
 
Для запуску функції Орієнтування натисніть і тримайте 
одночасно кнопку клавіатури і праву кнопку миші, поки 
не з'явиться екран Орієнтування.  
 
 
 
          Екран Орієнтування 

 

Кнопка Help (Допомога) 
Якщо на полиці з ручками є кнопка допомоги, натисніть її для запуску діалогового 
 вікна ―Допомога і підтримка для Вашої інтерактивної дошки SMART Board‖.  
Діалогове вікно надає доступ в один дотик до інформації, що допоможе вам відпо- 
вісти на майже будь-яке питання стосовно вашого продукту SMART. 
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Індикатор готовності (Ready Light) 
У Вашої інтерактивної дошки SMART Board є індикатор готовності, що показує статус вашої 
інтерактивної дошки. 

 
 
 

Колір індикатора 
готовності 

Статус  

Не світиться - Інтерактивна дошка не увімкнена 
- Перевірте підключення USB-кабеля 

Зелений - Інтерактивна дошка успішно спілкується з програмним 
забезпеченням SMART Board на комп'ютері 

Зелений, що миготить - Драйвер SMART Board не встановлений. Або, якщо він 
встановлений, він не працює. Перевірте, чи встановлено 
драйвер, і якщо ні, встановіть його. 
- Якщо Індикатор готовності продовжує миготіти зеленим, 
варто звернутися до представників служби підтримки по 
допомогу 

Червоний - Інтерактивна дошка увімкнена, але не підключена до 
комп'ютера 
- Під час увімкнення або перезапуску, Індикатор готовності 
на короткий час стає червоним 
- Такий короткий червоний сигнал є нормальним 

Жовтий, що миготить - Лише у випадку, коли ви оновлюєте програмне 
забезпечення з використанням Firmware Flashing Wizard 
компанії SMART 
- Це нормально 

Жовтий - Стан проблеми 
- Спробуйте ще раз настроїти інтерактивну дошку, 
відімкнувши її, а потім підключивши кабель USB до кінця 
інтерактивної дошки  

 

Написання нотаток 
Щоб зробити запис або малюнок, заберіть ручку з полиці для ручок і пишіть на поверхні інтерактивної 
дошки.  
 
Шар цифрових чорнил 

Коли ви забираєте ручку з полиці для ручок, навколо вашого робочого столу з'являється 
рамка і запускається панель інструментів Floating Tools (Інструменти, що плавають). Якщо 
вона не запускається негайно, натисніть значок SMART Board у ділянці повідомлень у 
нижньому правому кутку вашого екрана. Оберіть Show Floating Tools (Показати 
інструменти, що плавають) з меню. 
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Рамки вказують, що працює Шар цифрових чорнил, і ви можете писати на робочому столі так само, як 
би робили це на прозорому листку. Шар цифрових чорнил і його видимі рамки залишаються на місці до 
того часу, поки усі ручки і інструмент для стирання повернуть на полицю для ручок і ви доторкнетеся 
до дошки. 
 
    Панель Плаваючі   Прозоре 
    інструменти Рамка  написання        Захоплення написаного  
 

                                                                                                                             
Закрити Шар 

цифрових чорнил 

 
 

                                                      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ваш перший дотик до дошки після повернення усіх ручок на полицю викличе 
меню з налаштуваннями для захоплення вашого написаного тексту. Якщо ви 
бажаєте сховати це меню в майбутньому, натисніть Ink Layer 
Options...(Налаштування шару чорнил) і оберіть пункт Close ink layer with 
pointer. 
 
Для збереження зображення на екрані, на якому ви писали на новій сторінці  
Notebook, оберіть Save Ink (Зберегти). Щоб очистити написане, але 
залишити в активному стані Шар цифрових чорнил, натисніть Clear Ink 
(Очистити). Щоб видалити Шар цифрових чорнил і очистити написане, 
оберіть Close Ink Layer (Закрити).  

 
Відновлення ваших записів і малюнків 
Якщо ви випадково видалили ваші чорнила, ви можете відновити ваші записи і 
малюнки, натиснувши на значок Click here to restore ink (Натисніть сюди для 
відновлення чорнила), розташований у нижній правій частині екрана. Потім ви можете 
використати кнопку Capture writing для збереження ваших записів. 
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Якщо ви не бачите повідомлення Click here to restore ink (Натисніть сюди для відновлення чорнил) 
або не встигаєте ним скористатися, поки воно не зникло, натисніть кнопку Undo (Відмінити) на панелі 
Плаваючих інструментів, щоб відновити ваші записи та малюнки. 
 

 
 
 
Кнопка Undo 

 
 

 

Додаткова функція — Захоплення ваших записів і малюнків 
Якщо ви бажаєте захопити певну ділянку вашого екрану, натисніть на значок SMART Board у ділянці 
повідомлень Windows у нижній правій частині екрану. Оберіть Other SMART Tools > Screen Capture 
Toolbar... (Інші інструменти SMART > Інструменти захоплення екрану) з меню для запуску Панелі 
інструментів для захоплення екрану. 
 
 
 
 
 
Кнопка захоплення ділянки     Кнопка вільного захоплення 
 
 
 
 
 
 

Кнопка захоплення вікна Кнопка захоплення екрану 
 

Для захоплення ділянки на вашому робочому столі, виконайте наступні кроки:  
 
1. Натисніть кнопку Area Capture (Захоплення ділянки) на  
             панелі Плаваючих інструментів. З'явиться інструмент Захоплення ділянки.  
2. Натисніть на будь-якому кутку ділянки, яку ви хочете  

захопити і, продовжуючи натискати, розтягніть  
рамки вибору, щоб вони оточили ділянку повністю. 

3. Відпустіть кнопку і ваша обрана ділянка буде  
захоплена як малюнок у програмі Notebook.  
Якщо програма Notebook ще не відкрита, вона  
автоматично відкриється, коли ви захопите частину  
екрану. Збережіть ваш файл Notebook, обравши  
File>Save (Файл > Зберегти). 
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Питання для перевірки: Початок роботи  
 
1. Назвіть три компоненти, необхідних для роботи з інтерактивною дошкою  
SMART Board. 
 
 
 
 
 
 
2. Як ви дізнаєтеся, коли інтерактивна дошка готова до використання? 
 
 
 
 
 
 
3. Обведіть кнопку на полиці для ручок, яка запускає Екранну клавіатуру. 

 
 

 
4. Опишіть один спосіб початку процесу орієнтування. 
 
 
 
 
 
 
5. Як здійснити натиск правою кнопкою миші на інтерактивній дошці? 
 
 
 
 
 
 
6. Назвіть два способи відновлення записів, які стерлися після закриття шару цифрових 
чорнил. 
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Відповіді для перевірки: Початок роботи 
 

 
1. Назвіть три компоненти, необхідних для роботи з інтерактивною дошкою SMART Board. 
 
 Інтерактивна дошка 
 Комп'ютер  
 Проектор  
 
 
2. Як ви дізнаєтеся, коли інтерактивна дошка готова до використання? 
 
 Індикатор готовності світиться зеленим. 
 
 
 
3. Обведіть кнопку на полиці для ручок, яка запускає Екранну клавіатуру. 
 

 
 
 
 
 
 
 
4. Опишіть один спосіб початку процесу орієнтування. 
 
 Натиснути і утримувати одночасно кнопку клавіатури і кнопку правої кнопки миші на  полиці для 
ручок. 
 
 
 
5. Як здійснити натиск правою кнопкою миші на інтерактивній дошці? 
 
 Натиснути кнопку правої кнопки миші на полиці для ручок, щоб наступне натиснення  на 
інтерактивну дошку розпізналося як натиснення на праву кнопку миші. 
 

 
 
 
 
 
 
 
6. Назвіть два способи відновлення записів, які стерлися після закриття шару цифрових чорнил. 
 
 Натиснути на кнопку Undo на панелі Плаваючих інструментів.  
 Натиснути на значок Click here to restore ink у нижній правій частині екрану. 
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Практичне завдання: Основні функції 
 
Ваша школа або компанія щойно перемістили одну з інтерактивних дошок SMART Board у нове 
приміщення, тому що зі старого місця у вас не було доступу до Інтернету. Ви будете першою особою, 
хто нею користуватиметься у новому оточенні і покажете усім, як користуватися нею і Інтернетом 
разом. 
 
З попереднього досвіду ви знаєте, що коли якийсь пристрій пересувають, непогано було б перевірити 
його перед тим, як давати урок або презентацію. Комп'ютер, інтерактивна дошка і проектор нібито 
працюють нормально, коли ви все увімкнули. Проте, коли ви двічі натискаєте на значок інтернет-
браузера на робочому столі, ваш курсор з'являється на кілька сантиметрів поодаль від вашого 
натиснення пальцем.  

 
Орієнтування вашої інтерактивної дошки SMART Board  
Ви пам'ятаєте, що коли проектор або інтерактивна дошка змінюють місце розташування, вам потрібно 
виконати орієнтування дошки. Ця дія скаже комп'ютеру, де зображення робочого столу показується на 
поверхні інтерактивної дошки. 
 
1. Щоб зорієнтувати інтерактивну дошку, одночасно натисніть і утримуйте кнопку Keyboard 
(Клавіатура) і кнопку right mouse (правої кнопки миші), поки не з'явиться екран Орієнтування. 
 
 
 
 

 
 

                                           
Кнопки полиці з ручками  
 
 
 
 

2. Почніть процес орієнтування у верхньому лівому кутку екрану орієнтування. Натисніть пальцем 
або ручкою в центрі кожного хрестика в порядку, зазначеному білими малюнками у формі діаманту. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Екран орієнтування 
 

Примітка: Точка зареєстрована, коли ви забираєте свій палець, а не коли ви вперше торкаєтеся до 

екрану орієнтування. 
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Перевірка основних функцій 

Гарною ідеєю є перевірити основні функції вашої інтерактивної дошки, щоб упевнитися, що усі 
програми, які ви будете використовувати під час вашого уроку або презентації, нормально працюють. 
 
1. Пальцем двічі натисніть на значок інтернет-браузера (напр., Internet Explorer) для запуску 
Інтернету. 
2. Натисніть на кнопку On-Screen Keyboard (Екранна клавіатура) на полиці для ручок. 
 

 
 
 
 
 
 
3. Натисніть один раз всередині адресної строки вашого інтернет-браузера для вибору адреси 
веб-сайту. 
 

 
 

4. Використовуючи екранну клавіатуру, наберіть www.google.com 
 

 
 
Примітка: Екранна клавіатура — це єдина точка контакту. Друкування з дотику або комбінації  штрихів 

не можливі. 
5. Натисніть кнопку Go поруч з адресним рядком вашого інтернет-браузера 
 
 
 

http://www.google.com/
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6. Візьміть ручку з полиці для ручок. З'явиться Шар цифрових чорнил, як показує видима рамка 
навколо робочого столу. Рамка показує, що ви можете писати на робочому столі, і вона 
залишиться на місці, поки ви не закриєте її або не перейдете до іншої програми. 

 
 

←Рамка Шару цифрових чорнил 
  

 
 
 
 
 
 
 

 
7. Використовуючи ручку, обведіть кнопку Back (Назад) на браузері. 
8. Поверніть ручку на полицю для ручок і один раз торкніться до інтерактивної дошки. Оберіть 
Choose ink з меню, щоб стерти ваш запис. Натисніть значок Click here to restore ink у нижній правій 
частині екрану, щоб повернути обведення. 
 

 
 
 
 Тепер ви підтвердили, що можете видаляти ваші записи шляхом дотику до інтерактивної дошки, 
а потім відновлювати ваші записи шляхом натискання значка Click here to restore ink. 
9. Щоб пересвідчитися, що ви можете захопити і зберегти важливу інформацію для майбутнього 
уроку або презентації, запустіть панель інструментів Screen Capture, натиснувши на значок SMART 
Board, розташований у ділянці повідомлень Windows у нижній правій частині вашого екрану. Оберіть 
Other SMART Tools...>Screen Capture Toolbar... з меню. 
10. Натисніть кнопку Area Capture (захоплення ділянки) 
 
 
 
 
Кнопка Захоплення ділянки 
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11. Натисніть інтерактивну дошку і, не послабляючи тиску, розтягніть рамки вибору пальцем , щоб 
окреслити коло навколо кнопки Назад у вашому браузері. Приберіть своє натиснення для 
захоплення зображення у програму Notebook. 

 
 
 
 
 
 
 
 
 
 
 
 
Примітка: Програма Notebook відкриється автоматично, і всі ваші записи і тло збережуться у новій 
сторінці Notebook. 
 
12. Приберіть коло з кнопки Назад на вашому браузері. 
 
13. Оберіть не збережений файл Notebook з вашої панелі задач, щоб переглянути ваш захоплений 
малюнок у програмі Notebook. Оберіть File > Save, щоб зберегти ваші записи для перегляду в 
майбутньому. 
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Робота з 
програмами Ink 
Aware 
 
Що таке Ink Aware? 
Якщо програма є Ink Aware, ви можете писати і малювати прямо в активному файлі. Наприклад, якщо 
ви напишете нотатку або щось намалюєте під час користування програмою Microsoft® Word , ви 
зможете зберегти ваш файл Word, і ваші нотатки буде видно, коли ви відкриєте його наступного разу.   
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} 

} 

Робота з програмами Ink Aware 
 

Як працюють програми Ink Aware? 
Програми Ink Aware розпізнають, яка ділянка програми є активною робочою ділянкою і яка ділянка 
використовується для кнопок і панелей інструментів. 
 

 
 
 
    Ділянка з кнопками і 
    панелями інструментів   
 
 
 
 
 
 

Активна робоча 
ділянка 

 
 
 
 

 

Які програми є Ink Aware? 
 

Microsoft 

Office 

Microsoft Word, Microsoft Excel®, OpenOffice Calc, OpenOffice Writer 
 

Графічні 
програми 

CorelDRAW®, OpenOffice DRAW, Microsoft Imaging, Corel® Grafigo™ 2, 
Microsoft 
Paint®, ArcView, Autodesk® DWF Composer 2.0, Volo® View Express 

Програми для 
презентацій 

Microsoft PowerPoint®, Corel Presentations™, Microsoft Office Live 
Meeting, 
Microsoft NetMeeting® 2.0/2.1/3, OpenOffice Impress 

Інші програми AutoCAD®, AutoVue™ Professional, Microsoft Windows® Journal, 
Microsoft Office 
OneNote®, Microsoft Visio®, Adobe® Acrobat® Professional 6.0/7.0/8.0 

 
Цей розділ зосередиться на програмах, які використовуються найчастіше: Microsoft Word, Excel and 
PowerPoint. 
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Програми Microsoft Word та Excel 
Використовуючи програми Word або Excel разом з вашою інтерактивною дошкою SMART Board, ви 
побачите чотири кнопки. Вони можуть бути інтегровані у панель інструментів програми або 
відокремлені у плаваючу панель інструментів. 
 

Зберегти знімок екрану в в програмі Notebook 

 
 
Вставка малюнків або письмовому вигляді  
зображення безпосередньо в документ 

 
 

Перетворення письмовому вигляді друкованого тексту безпосередньо в документі.  
Колір тексту буде співпадати з коліром використовуваним курсором ручки. 

 

Вставити малюнок або запис як зображення прямо в документ  
 

Автоматично вставити малюнок як зображення 
 

Переконвертувати запис у друкований текст прямо в документ. Текст з'явиться на позначці курсору 
кольору ручки, що використовується. 
 

Якщо ви не бачите цієї панелі інструментів, оберіть View > Toolbar > SMART Aware Toolbar. 
 

Приклад Word: Натиснути кнопку Insert as Image (Вставити як зображення) 

До того, як ви натиснете на кнопку, зображення 
не є частиною документу Microsoft Word. Його 
можна бачити лише на інтерактивній дошці. 

 
 

Натисніть кнопку, і зображення стане частиною  
документу Microsoft Word. 
 

 

Приклад Excel: Натиснути кнопку Insert as Text (Вставити як текст) 

До того, як ви натиснете на кнопку, зображення 
не є частиною файлу програми Excel. Його можна 
бачити лише на інтерактивній дошці. 

 
 

Натисніть кнопку, і зображення стане частиною файлу 
програми Excel. 
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Програма Microsoft PowerPoint 

Коли ви працюєте з програмою Microsoft PowerPoint на інтерактивній дошці у вигляді Нормальний, ви 
можете зберегти ваші написані вручну нотатки як зображення або текст і зберігати захоплення екрану 
у програму Notebook, так само як і в програмах Microsoft Word або Excel. Доступ до функцій Ink Aware 
можна отримати через Плаваючі інструменти Aware, які запускаються, коли ви берете ручку, щоб 
зробити записи або намалювати малюнки. Зверніть увагу, цю панель інструментів ви побачите лише у 
вигляді Нормальний. 

Плаваючі інструменти Aware 

 
 

 
 
 
 
Вставити малюнки або         Зберегти захоплення  
запис як зображення                                                екрану в програму SMART Notebook 

 
Переконвертувати записи у друкований текст 

 

Коли ви робите презентацію, використовуючи на інтерактивній дошці програму PowerPoint, ви також можете 

зберігати ваші записи і зображення та зберігати захоплення екрану а програму SMART Notebook. До програм 

Ink Aware можна отримати доступ через панель інструментів Слайд-шоу, яка запускається, коли ви входите 

вигляд Слайд-шоу. Зверніть увагу, цю панель інструментів ви бачите лише у вигляді Слайд-шоу. 
                           
  Панель інструментів Slide Show 

 
 
 
 
Перейти до попереднього слайду        Перейти до наступного слайду у 
вашій презентації        у вашій презентації 

 
 

Відкрити командне меню 
 

Порада: Ви можете перейти до наступного слайду у презентації в програмі PowerPoint, двічі 
натиснувши на інтерактивну дошку так, щоб друге натискання було справа від першого. Щоб перейти 
до попереднього слайду, зробіть друге натискання зліва від першого. 
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Командне меню 
Натисніть центральну кнопку на панелі інструментів Slide Show для запуску Командного меню. 
 
 
 
 
 
 
 
Захопити зображення даного  
слайду в програму SMART Notebook 
           Зберегти ваші записи прямо в  
Видалити ваші записи зі сторінки        файл презентації PowerPoint 
 

Додати додатковий слайд  
до вашої презентації 

 
Запустити підменю команд  
PowerPoint          Запустити підменю 

Налаштування 
Запустити панель інструментів  
Плаваючі інструменти 

Завершити слайд-шоу
 
 

Підменю команд PowerPoint 
 
                   Відкрити меню програми PowerPoint 
 
 
 

Перейти до будь-якого слайду у вашій презентації 
 
 
 

 Зробити екран чорним 
 
 

Надрукувати слайд на вашому принтері 
 
 
 
 
 
 
                   Відкрити меню програми PowerPoint 
 

Порада: Використовуйте команду Black/Unblack Screen, коли бажаєте привернути увагу вашого класу 
або аудиторії від екрану на особу, яка проводить презентацію. Швидко натисніть двічі будь-де на 
екрані для відновлення вашого слайд-шоу точно з того місця, на якому ви зупинилися. 
 
Підменю Налаштування 
 
 
 
 
 
 
 

Прибрати галочку, щоб перелистувати слайди одним дотиком 
 
 

Прибрати галочку, якщо не бажаєте зберігати  
ваші малюнки наприкінці показу 

 
Прибрати галочку, щоб отримати непрозору 
панель інструментів 
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Панель інструментів Плаваючі інструменти SMART 

Панель задач операційної системи Windows і ділянка повідомлень сховані, коли ви виконуєте показ 
слайд-шоу в програмі PowerPoint. Проте, ви можете запустити панель інструментів Плаваючі 
інструменти, обравши SMART Floating Tools з командного меню. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Поради: 
1. Використовуйте кнопки панелі інструментів Ink Aware для конвертування ваших записів прямо в 

програми Microsoft Word та Excel. 

2. Панель інструментів Slide Show в програмі PowerPoint дозволяє керувати презентацією PowerPoint, 

поки ви перебуваєте на інтерактивній дошці SMART Board. 

3. Ви можете запустити панель Плаваючі інструменти під час слайд-шоу програми PowerPoint, обравши 

Slide Show Toolbar > Command Menu > SMART Floating Tools.
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Питання для перевірки: Ink Aware 

1. Опишіть функцію кожної кнопки на панелі інструментів Ink Aware, що з'являється в програмі 
Microsoft Word. 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Опишіть, як вставити цифрові чорнила як текст в обрану ячейку таблиці програми Excel. 
 
 
 
 
 
 
 
 
 
 
3. Опишіть, як зберегти запис у слайді PowerPoint у програму SMART Notebook у вигляді Слайд-
Шоу. 
 
 
 
 
 
 
 
 
 
4. Опишіть, як зберегти ваші записи і малюнки у файли програми PowerPoint.  
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Відповіді для перевірки: Ink Aware 
 
1. Опишіть функцію кожної кнопки на панелі інструментів Ink Aware, що з'являється в програмі 
Microsoft Word. 

 
 
 Вставити як Зображення: Вставити записи як зображення в документ або таблицю 

 Вставити як Текст: Конвертує записи у друкований текст і вставляє його у документ або 
таблицю 

 Захопити у SMART Notebook: Захоплює видиму активну робочу ділянку у програму SMART 
Notebook 

 Налаштування дозволяють автоматично вставляти малюнки в документ як зображення 

 
2. Опишіть, як вставити цифрові чорнила як текст в обрану ячейку таблиці програми Excel. 

 
Щоб зберегти цифрові чорнила як текст, треба натиснути кнопку Insert as Text на панелі інструментів 
Ink Aware. 

 
 
 
 
3. Опишіть, як зберегти запис у слайді PowerPoint у програму SMART Notebook у вигляді Слайд-
Шоу. 

 
Натиснути центральну кнопку на панелі інструментів Слайд-шоу з трьох кнопок і обрати Capture to 
Notebook. І слайд, і записи будуть захоплені як зображення у програмі SMART Notebook. 

 
 
 
4. Опишіть, як зберегти ваші записи і малюнки у файли програми PowerPoint.  
 
Натиснути центральну кнопку на панелі інструментів Слайд-шоу з трьох кнопок і обрати Insert Drawing 
as Image.  
 
Якщо ви не збережете ваші записи і перейдете до наступного слайду, ви отримаєте запит на 
збереження ваших записів наприкінці слайд-шоу. Цю опцію можна вимкнути у підменю Налаштування. 
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Практичні завдання: 

Ink Aware і програма Microsoft Word у класі 
 
Перед початком 
Перед початком вашого уроку, переконайтеся, що ваш комп'ютер увімкнений, а інтерактивна дошка 
SMART Board підключена і процес її орієнтування проведений. 
 
Для виконання практичного завдання вам потрібно базове розуміння операційної системи Microsoft 
Windows. 
 
Підготовка 
Створити короткий тест з двох питань. У реальній ситуації ви відкриватимете тест, заготовлений 
заздалегідь. 
 
1. Відкрийте новий документ у Word. 
2. Надрукуйте математичне рівняння за допомогою комп'ютерної клавіатури — наприклад, 13 х 7 
=. Натисніть клавішу Enter (Ввести) кілька разів, щоб дати вашим учням місце для показу своєї роботи.  
3. Надрукуйте Доповніть наступне речення словами “швидкий” або “швидко”. Натисніть клавішу 
(Ввести) двічі, потім надрукуйте Коли вона хвилюється, вона говорить дуже 
 

Використання Ink Aware у класі 
Ваш клас тільки що виконав тест, який ви створили у Word. Тепер ви хочете переглянути відповіді як 
групу. 
 
1. Використайте ручку з полиці для ручок SMART для демонстрації, як отримати правильну відповідь 
на інтерактивній дошці. Покладіть ручку назад на полицю для ручок і натисніть кнопку Insert as image 
(Вставити як зображення), щоб додати відповідь до вашого файлу Word. 
 
 
2. 
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2. Перейдіть до наступного питання тесту. Обговоріть з класом, коли слід використовувати слово 
швидкий, а коли швидко у реченні. 
3. Доторкніться до інтерактивної дошки, щоб помістити курсор в кінець речення. 
 

 
 
4. Скористайтеся ручкою з полиці для ручок, щоб написати правильну відповідь на інтерактивній 
дошці. 
 

 
 
5. Натисніть кнопку Insert as text (Вставити як текст), щоб конвертувати правильну відповідь у 
текст. Текст з'явиться на позначці курсору такого кольору, який має ручка, що використовується.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Збережіть ваш документ у Word. Тепер ви можете надіслати відповіді електронною поштою 
або надрукувати копії і роздати вашим учням. 
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Практичне завдання:  
Ink Aware і програма Microsoft Excel в офісі 
 
Перед початком 
Перед початком вашого уроку, переконайтеся, що ваш комп'ютер увімкнений, а інтерактивна дошка 
SMART Board підключена і процес її орієнтування проведений. 
 
Для виконання практичного завдання вам потрібно базове розуміння операційної системи Microsoft 
Windows. 
 

Підготовка 
 
1. Відкрийте нову таблицю в програмі Excel. 
2. Надрукуйте Готель у ячейці А2 на комп'ютерній 
клавіатурі. 
3. Надрукуйте Політ у ячейці А3 
4. Надрукуйте 1000 у ячейці В3 
 

 
Використання Ink Aware в офісі 
Уявімо, що ви разом з колегами плануєте незабаром поїхати на конференцію. Як група, ви готуєте 
запит на подорож, зазначивши очікувані витрати. Цей запит буде представлено   відділу бухгалтерії 
для схвалення. 
 
1. Один з членів групи стверджує, що готель коштуватиме $150 за добу. Натисніть ячейку у 
таблиці, щоб виділити ячейку, у якій буде зазначено вартість. Візьміть ручку з полиці для ручок SMART 
і напишіть на інтерактивній дошці 150. 
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2. Інший член групи зауважує, що корпоративні витрати на готель становлять лише $115 за добу. 
Покладіть ручку назад на полицю для ручок і натисніть на інтерактивну дошку один раз, щоб стерти 
150. Потім натисніть на ячейку в таблиці, в яку буде розміщено нову вартість. Напишіть 115. 
 

 
 
3. Натисніть кнопку Insert as text (Вставити як текст), щоб додати вартість готелю у виділену 
ячейку. Ваш текст вставлено в таблицю і з'явиться такого кольору, який має ручка, що 
використовується. 
 
 
 
 
 
 
 
 
 
4. Нарешті, голова вашої команди пропонує, щоб ви отримали мінімум три варіанти ціни за 
переліт. Обведіть вартість перельоту у ячейці А3 і напишіть Отримати розцінки. Натисніть кнопку 
Insert as image (Вставити як зображення), щоб вставити ваш запис як зображення у таблицю. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Збережіть вашу таблицю як файл програми Excel. Тепер ви можете оновити запит на подорож 
згідно з нотатками вашої групи і надіслати його електронною поштою до відділу бухгалтерії для 
схвалення. 
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Практичне завдання: Використання програми PowerPoint на інтерактивній 

дошці SMART board  

 
Перед початком 
Перед початком вашого уроку, переконайтеся, що ваш комп'ютер увімкнений, а інтерактивна дошка 
SMART Board підключена і процес її орієнтування проведений. 
 
Для виконання практичного завдання вам потрібно базове розуміння операційної системи Microsoft 
Windows. 
 

Підготовка 
Уявімо, що ваш начальник попросив провести коротку презентацію на тему продуктивності в офісі. 
Попередня робота по презентації вимагає, щоб ви включили в неї відгуки і пропозиції ваших колег. 
Остаточна презентація буде представлена вашому начальнику. 
 
Приклад файлу програми PowerPoint для цього уроку можна знайти на 
www.smarttech.com/media/trainingcenter/samplepresentation.ppt. Якщо цей файл відкриється у вашому 
веб-браузері, збережіть його на робочий стіл, а потім відкрийте знову. 
 
Як варіант, відкрийте існуючу презентацію програми PowerPoint, збережену на вашому комп'ютері. 
Кроки у цьому практичному завданні  можна виконувати, навіть якщо ви використовуєте власну 
презентацію на інтерактивній дошці. 

 
Презентація на інтерактивній дошці 
1. Оберіть View > Slide Show (Вигляд > Показ слайдів), щоб розпочати вашу презентацію. 
З'явиться панель інструментів Слайд-шоу, щоб ви могли переходити між слайдами. 
2. Натисніть кнопку Next Slide (Наступний слайд) на панелі інструментів Слайд-шоу, щоб перейти 
на один слайд вперед. Потім натисніть кнопку Previous Slide (Попередній слайд), щоб повернутися на 
один слайд назад. 
 

Порада: Ви можете перейти до наступного слайду в презентації в програмі PowerPoint, натиснувши 
двічі на інтерактивній дошці таким чином, щоб друге натиснення було справа від першого. Щоб 
повернутися до попереднього слайду, зробіть друге натиснення зліва ід першого. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                                                  
 
Натисніть двічі. Друге натискання справа дозволить        Натисніть двічі. Друге натискання зліва дозволить перейти до 
наступного слайду.                                                                      перейти до попереднього слайду. 
 

http://www.smarttech.com/media/trainingcenter/samplepresentation.ppt
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3. Продовжуйте слайд-шоу, натискаючи двічі на інтерактивну дошку, не забуваючи робити друге 
натискання справа від першого. 
4. Для наголошення ви бажаєте привернути увагу вашої аудиторії до слів, зазначених на слайді 
PowerPoint. Візьміть ручку з полиці для ручок SMART і намалюйте ―галочку‖ біля кожного пункту, коли 
обговорюєте його з колегами. 
 

 
 
5. Після обговорення ви вирішили стерти позначки. Поверніть ручку на полицю для ручок і 
пальцями торкніться до інтерактивної дошки один раз, щоб стерти ваші нотатки. 
6. Використайте панель інструментів Слайд-шоу або двічі натисніть на інтерактивну дошку, щоб 
перейти до наступного слайду. 
7. Ваші колеги цікавляться статистикою, яку ви зазначили на вашому слайді PowerPoint і просять 
вас надіслати їм матеріал, звідки ви взяли цю інформацію. Запишіть їхнє прохання як нотатку, щоб 
нагадати собі надіслати їм це пізніше. Візьміть ручку з полиці для ручок і напишіть надіслати 
матеріали. 
 

 
 
8. Поверніть ручку на полицю для ручок. 
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9. Оскільки ви хочете виконати завдання з вашої нотатки, але не бажаєте зберігати її як постійну 
частину вашої презентації, натисніть кнопку Menu (Меню) на панелі інструментів Слайд-шоу і оберіть з 
випадаючого списку Capture to Notebook. Програма SMART Notebook відкриється автоматично, і 
зображення вашого слайду PowerPoint з вашим записаним нагадуванням буде вставлене у новий 
файл SMART Notebook. 
 
 
 
 

↑ 
→ Новий файл SMART Notebook 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Тепер, коли ваше нагадування було захоплене у програму SMART Notebook, натисніть один 
раз на інтерактивну дошку, щоб стерти вашу нотатку з презентації в програмі PowerPoint.Перейдіть до 
наступного слайду. 
11. Наступний слайд у вашій презентації вимагає відгуку від ваших колег. Візьміть ручку з полиці 
для ручок і запишіть їхні пропозиції. 
 

 
 
12. Ой! Після того, як ви поклали ручку назад на полицю для ручок, ви випадково стерли ваші 
нотатки. А що, якщо ви хотіли зберегти цю інформацію? 
 
 Перед тим, як знову взяти ручку, натисніть на значок Click here to restore writing  (Натисніть 
сюди, щоб відновити написане), розташований у правому крайньому кутку екрану. Ваші нотатки знову 
з'являться на слайді.
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Порада: Якщо значок Click here to restore writing зник з інтерактивної дошки, не хвилюйтеся. 
Натисніть кнопку Menu на панелі інструментів Слайд-шоу і виберіть Restore Drawing (Відновити 
малюнок). 

 
13. Ви готові до завершення вашої презентації. Натисніть на кнопку Menu на панелі інструментів 
Слайд-шоу і оберіть End Show (Завершити показ) з меню, що випадає. Оберіть Yes (Так) у віконці 
повідомлень SMART Aware, щоб додати ваші нотатки до презентації програми PowerPoint. 
14. Оберіть File > Save (Файл > Зберегти), щоб зберегти ваші нотатки у вашу оригінальну 
презентацію, або оберіть File > Save As (Файл > Зберегти як), щоб зберегти їх у новий файл програми 
PowerPoint. Закрийте вашу презентацію. 
15. Тепер оберіть не збережений файл SMART Notebook, створений раніше під час уроку. Оберіть 
File > Save (Файл > Зберегти), щоб зберегти ваші записи для подальшого використання. 
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Основи роботи  з 
програмою 
SMART 
Notebook 
 
Що таке програма SMART Notebook? 
 
Програма SMART Notebook — це програма SMART для інтерактивної дошки. Використовуйте її у класі 
для створення цікавих і інтерактивних завдань для уроків.  
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Основи програми Notebook 
 

Використання програми SMART Notebook вперше  
 
Щоб запустити програму Notebook, двічі натисніть на значок SMART Notebook на робочому 
столі. Або натисніть на кнопку Start (Пуск) у нижньому лівому кутку вашого екрану і оберіть 
Programs > SMART Board Software > SMART Notebook (Програми  > Програма SMART 
Board > SMART Notebook). З'явиться екран Welcome to Notebook Software (Ласкаво 
просимо до програми Notebook).  

 

 
 
Коли ви натиснете на New Notebook File, відкриється новий файл. Кожний новий файл SMART 
Notebook містить робочу ділянку, яку можна заповнити об'єктами. У файл SMART Notebook ви можете 
додавати нотатки, написані вручну, друкований текст, графіку, кліп-арт і файли Flash. Головною 
функцією програми SMART Notebook є можливість додавати стільки сторінок, скільки вам потрібно, 
щоб показати інформацію.  
 
 

 

 

 

 

 

 

Робоча зона 
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Панель меню програми SMART Notebook 
 
Панель меню програми SMART Notebook надає доступ до багатьох інструментів та функцій, які можна 
знайти в панелі інструментів програми SMART Notebook і у деяких додаткових інструментах. Натисніть 
на позиції меню, до якого ви хочете отримати доступ. 
 
 

 
Панель меню 
 
 

Позиція меню Функції 

Файл - Відкриває нові або існуючі файли 
- Зберегти файл 
- Зберегти Як — зберегти файл вперше, зберегти файл під новим ім'ям 
або зберегти файл у новому місці 
-  Зберегти поточну сторінку як частину Галереї 
- Імпортувати різноманітні файлові формати 
- Експортувати контент у різноманітні файлові формати 
- Надрукувати файли або змінити налаштування для друку 
- Надіслати файл електронною поштою як файл Notebook або PDF 
- Заплановані збереження — оберіть як часто має автоматично 
зберігатися ваш файл (рекомендуємо встановити цей показник на 15 
хвилин) 
- Подивитися список нещодавно відкритих файлів 

Редагувати - Відмінити або відновити попередні дії 
- Клонувати, вирізати, копіювати, вставляти або видаляти обрані об'єкти 
або всі об'єкти на сторінці 
- Редагувати текстовий об'єкт 
- Вибрати усі незакріплені або закріплені об'єкти на сторінці 
- Очистити або отримати останню сторінку 

Вигляд  - Змінити поточний вигляд бокової панелі (Сортувальник сторінок, 
Галерея, Додатки) 
- Перейти до наступної або попередньої сторінки 
- Запустити інструмент Захоплення екрану або Затінення екрану 
- Сховати боковий скроллбар 
- Налаштувати панель інструментів 
- Змінити вигляд на повноекранний режим 
- Збільшити або зменшити ваш вигляд вмісту сторінки 
- Показати всі посилання 
- Обрати мову, якою показує програма SMART Notebook 

Вставити - Додати чисту сторінку, малюнок, графічний файл, файл Flash, 
відеофайл Flash або об'єкт з Галереї. Додати посилання, звуковий файл 
або таблицю. 
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Пункт меню Функції 

Формат - Змінити стилі шрифту (жирний, підкреслений, курсив) 
- Встановити властивості об'єкта (колір, ширина лінії, стиль лінії, 
заливка, прозорість)  
- Закріпити властивості об'єктів та позицію 
- Невизначено клонувати обраний об'єкт 
- Змінити фоновий колір сторінки  
- Створити або встановити теми сторінки 
- Встановити значення вирівнювання тексту за замовчуванням 

Намалювати - Групувати, розгрупувати, перекинути або розташувати у порядку 
об'єкти  
- Обрати об'єкти 
- Отримати доступ до інструментів Ручка, Творча ручка та Стирачка 
- Створювати форми і лінії тексту 
- Обрати інструмент заливки 
- Обрати вигляд, розмір і колір шрифту за замовчуванням 

Допомога - Отримати доступ до файлу допомоги програми SMART Notebook 
- Перевірити наявність оновлення програми 
- Взяти участь у Програмі відгуків користувачів 
- Отримати доступ до інформації про програму SMART Notebook 

 
 
Порада: Отримати доступ до випадаючого меню з панелі меню програми SMART Notebook можна 
також шляхом утримання Alt або Ctrl і натисненням підкресленої літери в пункті меню (напр., Edit — це 
Alt + e, а Save – це Ctrl + s).
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Панель інструментів програми SMART Notebook  
 
Панель інструментів програми SMART Notebook забезпечує доступ до ряду інструментів, які 
допоможуть вам в роботі з файлом Notebook. За замовчуванням, панель інструментів з'являється на 
сторінці SMART Notebook згори. 

 
 

Кнопка Використовуйте цей інструмент, 
щоб 

Кнопка Використовуйте цей інструмент, щоб 

 

Показати попередню сторінку 
SMART Notebook 

 

Вставити таблицю 

 

Показати наступну сторінку SMART 
Notebook  

Обрати будь-який об’єкт на сторінці за 
допомогою пальця або миші 

 

Вставити чисту сторінку SMART 
Notebook одразу за поточною 
сторінкою 

 

Написати або намалювати на сторінці 
SMART Notebook ручкою 

 

Відкрити існуючий файл SMART 
Notebook 

 

Написати або намалювати на сторінці 
SMART Notebook інструментом Creative 
Pen 

 

Зберегти файл SMART Notebook 

 

Стерти цифрові чорнила на сторінці 
SMART Notebook 

 

Вставити скопійований об'єкт(и) у 
файл SMART Notebook 

 

Намалювати лінію 

 

Відмінити останню виконану дію 

 

Створити фігуру 

 

Повернути останню виконану дію 

 

Намалювати фігуру на сторінці SMART 
Notebook інструментом Shape Pen 

 

Видалити будь-який обраний об'єкт  

 

Використати Magic Pen для збільшення 
та прожектору або написати чорнилами, 
що зникають  

 

Показати/сховати Затінення екрану 
на поточній сторінці SMART 
Notebook 

 

Використати поточний ефект заливки для 
заливки об'єкта  

 

Відкрити повноекранний вигляд 

 

Створити вікно для введення тексту 

 

Запустити показ двох сторінок 

 

Змінити властивості обраного об'єкту  

 

Запустити панель інструментів 
Screen Capture  

Пересунути панель інструментів униз 
сторінки SMART Notebook  

 

Активувати Камеру для документів 
SMART 

  

 
За замовчуванням, панель інструментів з'являється на сторінці SMART Notebook вгорі. Якщо бажаєте, 
можливо, зручніше буде пересунути  панель інструментів униз сторінки. Для цього натисніть на 
подвійну вертикальну стрілку з крайнього правого боку панелі інструментів.  
 

Інструмент для пересування панелі інструментів  
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Додаткові налаштування для панелі інструментів 
Коли ви натискаєте на деякі кнопки панелі інструментів, вам пропонуються додаткові опції для 
створення об'єктів SMART Notebook.  
 
, 

Ручка    

     

 

 

 
 

Лінія    

     

 

 

 
Фігура   

 

 
 
Творчий 

інструмент перо 

 
 
Текст  

    

 

 

 
Стирачка



 42 

 

 

 
 

Бокові вкладки 
 
Збоку на інтерфейсі SMART Notebook розташовані чотири вкладки, які зображено нижче з правої 
сторони робочої ділянки. Натисніть двосторонню горизонтальну стрілку, щоб пересунути вкладки з 
однієї сторони робочої ділянки на іншу. Ви можете сховати бокову панель з виду після завершення 
роботи з ними, відмітивши квадратик Auto-hide. 

 
        
       
 
 
 
 

 
 
          Панель сортування  

сторінок 

 
 
          Панель Галерея 
Сторінку зі слайдами 

 
 
 

Панель Додатки 

 
          Панель Властивості 
 
 
 

Пересунути панель на  
Збільшити ширину ділянки         на іншу сторону  
показу панелі          робочої зони 
 
 
 
 

Випадаюче меню сторінки 
 
 
 

 
 
Попередня сторінка 

Робоча зона  
Наступна сторінка 

 
Додати сторінку 

 
 

Відмітка авто схову        Відмінити останню дію 
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Натисніть на панель Сортування сторінки, щоб побачити значки кожної сторінки у файлі SMART 
Notebook, перейдіть до іншої сторінки або змініть порядок сторінок. 
 
Натисніть на панель Галерея, щоб отримати доступ до шаблонів сторінок SMART, кліп-арту, флеш-
анімації та відео, які можна додати до файлу SMART Notebook.  
 
Натисніть на панель Додатки, щоб додати гіперпосилання або вкладення з інших програм до файлу. 
 
Натисніть на панель Властивості для форматування фігур, об'єктів та тексту. 
 

Панель Сортування сторінок 
 
Натисніть на панель Сортування сторінок, щоб побачити значки усіх сторінок у файлі  
SMART Notebook.  
 
Активна сторінка позначається другою рамкою навколо зображення і випадаючим 
меню. Натиснувши іншу сторінку у ділянці панелі Сортування сторінок, ви зробите цю 
сторінку активною, і її вміст буде показаний на робочій ділянці. Щоб змінити порядок 
сторінок, потягніть і відпустіть значок сторінки у її нове місце розташування. 
 
 
 
 
 
 
Друга рамка позначає  
активну сторінку 
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Випадаюче меню сортування сторінок  
Натиснувши на випадаюче меню на активній сторінці, ви отримаєте вісім опцій. 
 

 
 
 

Панель Галерея  
Галерея у програмі SMART Notebook допомагає швидко створити і показати урок, 
багатий на графічні елементи. Тисячі зображень, сторінок, відео, флеш-файлів та цілі 
файли  SMART Notebook організовані у колекції, у яких можна здійснювати пошук, що 
дозволить створювати привабливі уроки, які можна буде повторно використовувати.  
 
 

Пошук за ключовим словом 
 
 
Натисніть для перегляду 
попередніх пошуків 
 
 
 
 
 
Натисніть на колекцію, і її 
 вміст буде показано у  
нижньому вікні Галереї. 
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Пошук контенту Галереї 
Існує два способи пошуку контенту в Галереї. Поле пошуку у панелі Галерея дозволить вам шукати за 
ключовим словом — аналогічно до використання пошукової системи в Інтернеті. Далі ви можете 
переглядати колекції Галереї, обираючи папку. 
 
Для пошуку об'єктів у Галереї з використанням поля для пошуку, виконайте наступні кроки: 
 
1. Натисніть всередині поля для пошуку. 
2. Надрукуйте ключове слово, пов'язане з типом об'єктів, які ви шукаєте 
3. Натисніть на кнопку пошуку, щоб показати результати 
 
 
  

Натисніть тут для імпортування контенту в ділянку Мій 
контент колекцій Галереї 

 
 
 
 
 
 
 
 

Натисніть лупу для перегляду результатів пошуку у 
нижньому вікні Галереї 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Оберіть значок і перетягніть його у робочу ділянку 
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Як варіант, ви можете переглядати індивідуальні колекції, якщо шукаєте всі об'єкти, пов'язані з 
загальною темою, наприклад, Географія. 
 

 
 

Порада: Для кращих результатів пошуку шукайте об'єкти в однині, а не в множині
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Об'єкти в Галереї 
Об'єкти організовані у нижній ділянці Галереї за категоріями Малюнки і 
Тло, Інтерактив і Мультимедіа, Файли і сторінки  SMART Notebook і 
Related Folders.  
 
Натиснувши на значок папки у ділянці Related Folders, ви побачите усі 
об'єкти, розташовані в цій папці 
 
Pictures and Backgrounds (Малюнки та фон) містить фонові 
зображення і такі об'єкти як графіку, фотографії або текст. Ви можете 
перетягнути об'єкт до робочої ділянки для його використання як 
частину уроку або для зміни його властивостей. Перетягніть тло до  
SMART Notebook, щоб змінити колір і дизайн сторінки. Фонові 
малюнки розпізнаються за загнутим краєм у нижньому правому кутку і 
завжди вставляються позаду усіх об'єктів, які вже розміщені на 
сторінці SMART Notebook.  
 
Interactive and Multimedia (Інтерактив і мультимедіа) містить флеш-
об'єкти, відеофайли та об'єкти з доданим звуком. Об'єкти з цієї папки 
використовуються для додавання багатого медіа контенту до уроку 
або презентації. 
 
Додаткові файли і сторінки можна знайти у секції Галереї Notebook 
Files and Pages (Файли і сторінки Notebook). Значки сторінок SMART 
Notebook розпізнаються за загнутим краєм у верхньому правому кутку. 
Файли SMART Notebook розпізнаються за спіраллю зліва від їхніх 
зображень значків. Перетягнувши сторінку або файл SMART Notebook 
у робочу ділянку, ви вставите нову сторінку SMART Notebook або 
серію сторінок прямо за активною сторінкою.
 
 
Сторінка   Фон   Сторінка  SMART Notebook 

     
 
 
Об'єкт Flash  Аудіо-кліп  Відео-кліп 
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Онлайн-ресурси 
 

Натисніть на SMART Learning Marketplace або Online 
Essentials for Educators для доступу до додаткового контенту 
Галереї і відкриття освітніх ресурсів в Інтернеті. 
 
Ці онлайн-ресурси вимагають активного підключення до 
Інтернету і веб-браузер. 
 
SMART Learning Marketplace також доступний за підпискою. 
 
 
 

 
 
 
 
 
 
 
 
 

 
Мій контент 
Ділянка Мій контент — це колекція Галереї, зарезервована спеціально для об'єктів, які ви імпортували, 
перенесли або створили. Це гарне місце для збереження об'єктів, які ви використаєте у різноманітних 
презентаціях. Щоб додати об'єкт у ділянку Мій контент, перетягніть об'єкт з робочої ділянки у ділянку 
Мій контент. 
 
Якщо ви часто використовуєте певний шаблон сторінки, ви можете зберегти сторінку SMART Notebook 
як значок у ділянці Мій контент. Усі об'єкти, асоційовані зі збереженою сторінкою зберігають свої 
властивості. Для повторного використання збереженої сторінки, перетягніть її значок з ділянки Мій 
контент у робочу ділянку. 
 
Ви також можете зберігати цілий файл SMART 
Notebook у ділянці Мій контент, у разі, наприклад, 
якщо ви бажаєте робити презентацію багато разів. 
Для запуску файлу SMART Notebook з ділянки 
Галереї Мій контент, перетягніть його до робочої 
ділянки.  
 
Для імпортування інших файлів SMART Notebook з 
вашого комп'ютера, виконайте наступні кроки: 
 
1. Натисніть на My Content і натисніть на 
стрілку випадаючого меню сторінки. 
2. З випадаючого меню натисніть Add to My 
Content, щоб запустити діалогове вікно Додати у 
Мій контент. 
3. Перейдіть до файлу, який ви бажаєте 
додати. 
4. Натисніть на файл, який бажаєте додати. 
5. Натисніть кнопку Open. 
Ваш файл з'явиться як значок у ділянці Галереї Мій 
контент. 
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Панель Додатки  
Зробіть свою презентацію і уроки більш цілісною. Панель Додатки дозволяє посилатися 
на додаткові документи, програми і веб-сторінки прямо з вашого файлу програми 
SMART Notebook. Панель Додатків також є гарним способом збереження документів і 
веб-сайтів у вашій презентації SMART Notebook, яку ви, можливо, захочете 
використати у вашому уроці.  
 
Щоб вставити копію файлу, натисніть на кнопку Insert (Вставити) внизу панелі Додатки, виберіть Insert 
Copy of File Open (Вставити копію відкритого файлу) і перейдіть до місця розміщення файлу. 
Натисніть на файл і натисніть Open (Відкрити). Якщо ви перетягнете копію файлового додатка у вашу 
сторінку, вона стане об'єктом зі значком скріпки у верхньому лівому кутку. 
 
 
 

 
Значок файлу і значок гіперпосилання, які з'являються у 
робочій ділянці 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Коли у вас є додаток, асоційований з вашою презентацією, вигляд панелі Додатки зміниться, 
щоб нагадати, що там є додаток.
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Для введення інтернет-адреси натисніть Insert Hyperlink (Вставити гіперпосилання), надрукуйте 
інтернет-адресу, яку бажаєте додати і назву, яка буде показана на сторінці SMART Notebook. 
Натисніть ОК. 
 

 
 
Також бувають випадки, коли вам може знадобитися відкрити іншу програму, наприклад,програму 
Microsoft Word або Excel, при цьому залишаючись у програмі SMART Notebook. У цьому разі ви можете 
вставити ярлик у файл. Ці файли зазвичай є ―такими, що можуть виконуватися ―, тобто закінчуються на 
.exe. 
 

Як поділитися вашим файлом SMART Notebook 
Існує кілька способів, якими ви зможете поділитися вашим файлом SMART Notebook з колегами, які 
використовують програму SMART Notebook. Найлегший спосіб — зберегти ваш файл SMART 
Notebook, обравши File > Save і дозволивши іншим переглядати його. 
 
Ви також можете поділитися своїм цінним контентом, обравши File > Export  і зберігши її як веб-
сторінку для інтернет-користувачів або будь-кого, у кого не встановлено програму SMART Notebook. 
Контент також можна експортувати як серію файлів з зображеннями або PDF. Експортуйте ваш файл 
SMART Notebook як файл презентації PowerPoint, якщо хочете додати переходи до ваших слайдів. 
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Панель Властивості 
 
Щоб змінити характеристику об'єкта, натисніть на панель Властивості. Властивості, що 
показані, залежать від типу об'єкту, з який ви наразі працюєте. Наступний розділ 
детально розгляне, що можна змінити у кожному налаштуванні.  
 
 
 
Пам’ятайте, щоб обрати будь-який об’єкт за допомогою миші, спочатку треба натиснути на кнопку 
панелі інструментів Select (Обрати). 
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Змінити ефекти заливки 
У вас є багато опцій, коли ви змінюєте колір заливки об'єкта. Нижче показано дві з них. Об'єкт можна 
залити орнаментом або зображенням. Також можна змінити прозорість об'єкта.  
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Змінити стиль тексту  
Коли ви натискаєте на текстовий об'єкт і натискаєте панель Властивості, стають доступними кілька 
опцій Стиля тексту. Ви можете обрати Шрифт, Розмір і Стиль шрифту. 
 
Натисніть на стрілку випадаючого меню або натисніть на кнопки жирний, курсив, підкреслений, нижній 
або верхній індекс 
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Змінити стиль лінії 
Коли обрано об'єкт лінії і видно панель Властивості, можна змінити колір, товщину, стиль, початковий 
формат та кінцевий формат лінії. 
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Питання для перевірки: Основи роботи з програмою SMART Notebook 

 
 
1. Для чого потрібні чотири панелі у програмі SMART Notebook? 
 
 
 
 
 
 
 
 
 
2. Опишіть, як пересувати об'єкт з однієї сторінки SMART Notebook на іншу. 
 
 
 
 
 
 
 
 
 
3. Як додати пусту сторінку до програми SMART Notebook? 
 
 
 
 
 
 
 
 
 
4. Навіщо змінювати місце розташування панелей або панелі інструментів у програмі SMART 
Notebook? 
 
 
 
 
 
 
 
 
 
 
5. Для чого призначена панель Додатки? 
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Відповіді для перевірки:Основи роботи з програмою SMART Notebook 
 
      1. Які чотири панелі є в програмі SMART Notebook? 
 
 Сортувальник сторінок, Галерея, Додатки, Властивості 
 
 
 
 
 
 
1. Опишіть, як пересувати об'єкт з однієї сторінки SMART Notebook на іншу. 
 
 
 Щоб пересунути об'єкт, перетягніть його з робочої ділянки у ескіз сторінки в  Сортувальнику 
сторінок. 
  
 
 
 
 
 
 
2. Як додати пусту сторінку до програми SMART Notebook? 
 
 
 Натисніть кнопку зі знаком плюс на панелі інструментів або оберіть випадаюче  меню на 
панелі Сортувальника сторінок і оберіть Вставити чисту сторінку (Insert Blank Page). 
 
 
 
 
 
 
3. Навіщо змінювати місце розташування панелей або панелі інструментів у програмі SMART 
Notebook? 
 
 Панелі: у випадку викладання у команді або в залежності чи користувач є правшею  чи лівшею.  
 Панель інструментів: для того, щоб встановити зручну висоту для того, хто робить 
 презентацію, чи учасників, або тому що це надає можливість бачити верхню частину 
 робочого простору, яку в інших випадках може бути не видно. 
 
4. Для чого призначена панель Додатки? 
  
 Панель Додатки можна використовувати, щоб приєднати посилання на файли і веб-сторінки, 
до яких ви б хотіли звернутися під час презентації. Якщо файли або веб-сторінки приєднані за 
допомогою панелі Додатки, ваша презентація буде більш цілісною, оскільки вам не потрібно бути 
витрачати час на пошуки необхідного файлу або програми на вашому комп'ютері.  
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Практичне завдання: Основи роботи з програмою SMART Notebook  
 
Запуск програми SMART Notebook  
1. Запустити SMART Notebook, двічі натиснувши на значок програми SMART Notebook на 
робочому столі. 
2. Якщо з'явиться вікно Ласкаво просимо до програми Notebook (Welcome to Notebook Software), 
натисніть на New Notebook File (Новий файл Notebook). 
 

Редагування тексту  
3. Натисніть у робочій території і надрукуйте своє ім'я. Ваше ім'я з'явиться шрифтом Times New 
Roman, у звичайному стилі, 16-м кеглем і чорного кольору. 
 

 
 
4. Натисніть на панель Властивості і потім натисніть на ваше ім'я. На панелі Властивості 
натисніть Text Style (Стиль тексту). Змініть шрифт, розмір і стиль шрифту вашого імені.  
 

 
 
5. Натисніть на Line Style (Стиль лінії) на панелі Властивості. Змініть колір вашого імені. 
Натисніть значок Save (Зберегти) на панелі інструментів. Оберіть ім’я для вашого файлу і натисніть 
Save.  
 

 
 
6. Двічі натисніть на значок Add Page (Додати сторінку) на панелі інструментів, щоб додати ще дві 
сторінки до вашого файлу.  
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7. Натисніть на панель Page Sorter. Ви побачите ваші дві нові сторінки. 
Третя сторінка тепер є активною сторінкою, і вона пуста. Ваше ім'я 
залишається на першій сторінці. Натисніть на другу сторінку. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Створення лінії 
8. Натисніть на другу сторінку і оберіть значок Line (Лінія) на панелі інструментів. Намалюйте 
лінію у робочій ділянці. 
9. Натисніть панель Властивості і оберіть значок Select (Обрати) на панелі інструментів. Оберіть 
лінію, яку ви намалювали у вашій робочій ділянці. Тепер це активний об'єкт на сторінці.  
10. Натисніть Line Style (Стиль лінії) на панелі Властивості. Змініть колір, товщину, стиль, форму 
початку і форму кінця вашої лінії. Натисніть у робочій ділянці. Збережіть ваш файл SMART Notebook.  
 

 
 

 
 
11. Натисніть у панелі Сортування сторінок і оберіть третю сторінку. 
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Створення фігури 
12. Натисніть значок Shape (Фігура) на панелі інструментів і оберіть фігуру зірки з вкладеної панелі 
інструментів. Намалюйте зірку у робочій ділянці на третій сторінці. 
13. Натисніть на значок Select (Обрати) на панелі інструментів. Натисніть панель Властивості і 
оберіть вашу зірку. Ваша зірка є активним об'єктом на сторінці, а на панелі Властивості активне Fill 
Effects (Ефекти заливки). Змініть колір заливки вашої зірки. 
14. Натисніть на Line Style (Стиль лінії) у панелі Властивості. Змініть колір, товщину і стиль грані 
вашої зірки. Натисніть у робочій ділянці. Збережіть ваш файл SMART Notebook. 
 

 

 
 

 
Додавання контенту Галереї  
15. Натисніть на значок Select на панелі інструментів і натисніть на значок Add Page (Додати 
сторінку), щоб додати іншу сторінку до вашого файлу. Натисніть панель Сортування сторінок. 
Четверта сторінка стала активною сторінкою. 
16. Натисніть панель Галерея. У вікні пошуку надрукуйте bean plant (бобова рослина) і натисніть 
значок Пошук, що схожий на лупу. 
17. Натисніть Related Folders і натисніть на папку Plants 
(Рослини). Натисніть стрілку на папці і оберіть Open 
(Відкрити). 
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18. Натисніть Pictures and Backgrounds (Малюнки і тіло). Оберіть один з малюнків і перетягніть 
його у робочу ділянку. Ваш малюнок став активним об'єктом. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
19. Натисніть на панель Властивості і змініть прозорість малюнку. Збережіть ваш файл. 
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20. Натисніть на панель Сортування сторінок. Перетягніть четверту сторінку, щоб вона йшла 
одразу після першої сторінки. Збережіть ваш файл. 

 
Примітка: Коли ви перетягуєте сторінку до нового місця розташування, товста лінія показує її нову 

позицію. 
 
21. Поділіться вашими результатами з колегами. Закрийте програму SMART Notebook , 
натиснувши File > Exit. 
 



 63 

Об'єкти в програмі 
SMART Notebook    
 
Що таке об'єкт? 
 
Всі тексти, зображення, відео і мультимедіа вважаються об'єктами в програмі SMART Notebook. Ви 
можете змінити властивості цих об'єктів, щоб зробити презентацію більш ефективною. 
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Маніпуляції з об'єктами у програмі SMART Notebook  
Будь-що, розміщене в робочій ділянці, вважається об'єктом. Ви можете додати об'єкт у сторінку 
SMART Notebook одним з наступних методів: 
   

 Надрукувати текст 

 Намалювати або написати у робочій ділянці за допомогою ручки 

 Створити геометричну фігуру за допомогою інструментів малювання в панелі інструментів 
програми SMART Notebook 

 Вставити контент з Галереї, комп'ютера або Інтернету   
 
 

Зміна об'єктів  
Оберіть будь-який об'єкт на сторінці SMART Notebook, щоб змінити його властивості. Обрані об'єкти 
мають дві позначки. Використовуйте темну позначку для обертання об'єкту, а світлу для його 
збільшення або зменшення.   

Натисніть для випадаючого меню 
Потягніть для обертання об'єкта  

 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Потягніть для зміни розміру об'єкта   
 
 
 
 
 
 
 
 
 
 

Потягніть для зміни розміру 
об'єкта   

 
 
 
 

Потягніть для обертання об'єкта  
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Пересування об'єктів  
Щоб пересунути об'єкт з однієї сторінки на іншу, переконайтеся, що панель Сортування сторінок 
активна, а опція Авто-схову не відмічена. Потім натисніть на об'єкт, який ви хочете пересунути і 
перетягніть його на потрібну сторінку.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Перетягніть з активної сторінки (перша сторінка) на третю сторінку. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ви також можете пересувати об'єкти за допомогою команд Вирізати і Вставити з випадаючого меню і 
панелі меню. Натисніть на об'єкт, щоб його вибрати. З випадаючого меню об'єкта натисніть Copy 
(Копіювати) , якщо хочете зберегти оригінальний об'єкт, або Cut (Вирізати), якщо бажаєте видалити 
оригінальний об'єкт. Натисніть на сторінку, на якій ви хочете, щоб об'єкт з'явився. З випадаючого меню 
Edit (Редагувати) на панелі меню натисніть Paste (Вставити). 
 
 



 66 

 

Позначки вирівнювання (Alignment Guides) 
Позначки вирівнювання дозволяють вам контролювати розміщення об'єктів на сторінці, так щоб об'єкти 
розміщувалися саме там, де ви хочете. Натисніть Format > Alignment (Формат > Вирівнювання) з 
панелі меню, щоб встановити значення вирівнювання за замовчуванням. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Натисніть колір позначки, щоб змінити колір ліній            Лінії позначають центр вашої сторінки 
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Випадаюче меню об'єкта 
 
Випадаюче меню об'єкта надає вам доступ до властивостей об'єкта в одне натиснення. 
 

Пункт Опис 

Клонувати Створює точну копію об'єкта або об'єкти поруч з оригінальним об'єктом   

Вирізати Видаляє обраний об'єкт зі сторінки SMART Notebook і розміщує його у буфері 
обміну 

Копіювати  Створює ідентичну копію обраного об'єкта 

Вставити Розміщує об'єкт з буфера обміну  на сторінці SMART Notebook 

Видалити Видаляє обраний об'єкт  

Перевірити 
правопис 

Перевіряє правопис для обраного текстового об'єкту (ів)  

Замкнути  Захищає об'єкт або усю групу об'єктів від редагування. Оберіть між Замкнути на 
місці, Дозволити пересування і Дозволити пересування і обертання  

Групувати Групує два або більше об'єкти в один об'єкт. Обирайте, змінюйте, пересувайте, 
видаляйте і змінюйте розмір групи, неначе це єдине ціле. Щоб редагувати або 
змінити розмір об'єктів індивідуально, розгрупуйте їх.  

Перевернути Переверніть об'єкт горизонтально або вертикально. 

Порядок Змініть порядок, у якому пошарово розташовані об'єкти  

Численне 
клонування 

Зробіть необмежену кількість копій об'єкта на сторінці SMART Notebook. Оберіть і 
перетягніть об'єкт, щоб створити стільки клонів,  скільки потрібно. 

Посилання З'єднайте об'єкт з веб-сайтом, іншою сторінкою SMART Notebook, файлом на 
комп'ютері  або файлом на кшталт відеокліпу або іншого мультимедійного 
елементу, що розташований у панелі Додатки 

Звук Приєднайте звуковий файл до будь-якого об'єкта  

Властивості Змініть візуальні характеристики будь-якого об'єкта, який ви створили у програмі 
SMART Notebook  
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Випадаюче меню об'єкта   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Заблокувати об'єкти  
Блокування об'єкта дозволяє захистити властивості, які ви застосували до нього. Вибір у підменю  
Блокування (Locking) дозволяє визначити тип блокування, який слід застосувати стосовно об'єкту. 
 

 
 
Натисніть опцію Lock in Place (Закріпити на місці), щоб об'єкт не можна було жодним чином змінювати 
або пересувати. 
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Натисніть Allow Move (Дозволити пересування), щоб дозволити пересувати об'єкт, але не змінювати 
розмір, обертати або змінювати жодне з властивостей об'єкта. Ви можете використовувати функцію 
Дозволити пересування, якщо створюєте файл SMART Notebook, який будете використовувати у 
викладанні порядку, але хочете, щоб усі об'єкти на сторінці 
залишилися того ж розміру.  
 
Натисніть на Allow Move and Rotate (Дозволити пересувати і 
обертати), щоб дозволити пересувати і обертати об'єкт, але не 
змінювати його розмір. Ви також можете використовувати 
функцію Дозволити пересування і обертання, якщо ви створили 
файл SMART Notebook з компонентом мозаїки (пазл) і хочете, 
щоб ваші учні розмістили частини мозаїки як потрібно. Ви можете 
розмістити частини мозаїки, де завгодно на сторінці SMART 
Notebook, і розвернути їх, щоб ускладнити загадку, не 
переймаючись про те, що учасники можуть змінити розмір 
частинок. 
 
Розблокуйте об'єкт наступним чином: 
1. На панелі меню натисніть Edit > Select All Locked Nodes 
(Редагувати > Обрати усе заблоковане). Значок Замку з'явиться на усіх об'єктах, які ви заблокували. 
2. Натисніть на значок Lock (Замок). 
3. Натисніть Unlock (Розблокувати) у меню. Як варіант, натисніть правою кнопкою миші на об'єкт 
— з'явиться значок Lock з меню блокування. Натисніть Unlock з меню. 
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Групування об'єктів 
Оберіть два або більше об'єктів, утримуючи ліву кнопку миші і перетягнувши вашу мишу по діагоналі, 
так щоб об'єкти  були оточені рамкою. Ви також можете тримати клавішу Shift, поки натискаєте на 
кожний з об'єктів, які хочете згрупувати.  
 
Натисніть на випадаюче меню будь-якого з об'єктів і оберіть Grouping > Group.  
 

 
 
Якщо ви бажаєте відокремити об'єкти, виділіть згруповані об'єкти знову і оберіть Grouping> Ungroup.  
Функція Розгрупувати також розбиває нотатки, написані вручну,  на окремі штрихи ручки.
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Нескінченне клонування 
Коли ви натискаєте правою кнопкою миші на об'єкт, який треба клонувати необмежену кількість разів, у 
правому верхньому кутку з'являється символ нескінченності, а на об'єкті — текстове вікно з відміченим 
Infinite Cloner (Нескінченне клонування). 
 

 
←Символ нескінченності 
 
 
 
 
 
 
 
 
 

Опція Нескінченне клонування у випадаючому 
меню об'єкта дозволяє відтворювати об'єкт необмежену кількість разів без потреби повторного 
натиснення Клонувати у випадаючому меню. Ви можете використовувати Нескінченне клонування, 
викладаючи рахування або у математичних задачах. 
 
Оберіть, потім натисніть і перетягніть об'єкт, 
 щоб створити ідентичний об'єкт. 
 
 
 
 
 
 
 
 
 
 
 
 

Натисніть Infinite Cloner (Нескінченне клонування)  з випадаючого меню об'єкта. Тепер, коли ви 
натиснете і перетягнете об'єкт, який потрібно клонувати нескінченну кількість разів, створюється інший 
ідентичний об'єкт. Ви можете продовжувати створювати копії об'єкта шляхом перетягування, поки не 
відміните Нескінченне клонування. 
 
Щоб вимкнути функцію Нескінченного клонування, натисніть правою кнопкою миші на об'єкт і натисніть 
напис Infinite Cloner. Позначка зникне, показуючи, що Нескінченне клонування вимкнено. 
 
 
 
 
 
 
 
 
 
 
 
 

Задача про гроші є прикладом, як можна використо- 
вувати Нескінченне клонування. Монети справа  
необхідно клонувати нескінченну кількість разів.  
Учні перетягують правильні монети, які потрібно  
сплатити за об'єкт. 
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Перевернути об'єкт  
Натисніть Flip (Перевернути) з випадаючого меню об'єкта, щоб перевернути об'єкт горизонтально або 
вертикально.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Порядок об'єктів  
Ви можете змінити порядок, у якому пошарово розташовані об'єкти, обравши Order (Порядок) з 
випадаючого меню.  
 
Щоб змінити порядок об'єктів по одному шару за раз, скористайтеся командою Bring Forward (Винести 
вперед) або командою Send Backward (Відправити назад). 
 
Щоб винести об'єкт одразу на верхній шар сторінки, скористайтеся командою Bring to Front (Винести 
попереду).  
 
Щоб відправити об'єкт на нижній шар сторінки, скористайтеся командою Send to Back (Відправити 
позаду).  
 

 
  Чотири об'єкти розташовані шарами або у певному порядку двома різними способами
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Додавання посилань до об'єктів  
Ви можете додати посилання в об'єкті на веб-сайт, іншу сторінку SMART Notebook, файл на вашому 
комп'ютері або на файл у панелі Додатки. Натисніть Link (Приєднати/Посилання) з випадаючого меню 
об'єкта і оберіть типа посилання, яку хочете додати до вашого об'єкта з діалогового вікна Insert Link 
(Вставити посилання)  
 

 
 
Ви можете відкрити ваше посилання, натиснувши на значок збоку об'єкта або натиснувши на сам 
об'єкт. 

 
Посилання на веб-сторінку   
 

 
 
Після того, як посилання приєднане до об'єкта, щоразу, коли ви натискаєте на нього, запускається ваш 
інтернет-браузер і відображається ця сторінка.
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Посилання на сторінку в цьому файлі  
Ви можете використати цей вид посилання, ставлячи запитання. Наприклад, ви можете поставити 
питання, а потім попросити учня обрати з набору об'єктів, що представляють можливі питання. 
 
Об'єкт, що містить правильну відповідь, може мати посилання на призовий екран. Об'єкти, які містять 
неправильні питання, можуть мати посилання на сторінку, що заохочує учня спробувати ще раз.  
 

 
 

Посилання на файл у цьому комп'ютері  
Додайте посилання на файл, що зберігається на вашому комп'ютері, який стосується вашого уроку або 
презентації. Наприклад, ви можете додати посилання на файл програми Microsoft Word або Excel, що 
містить інформацію, яка підтверджує твердження у вашому файлі SMART Notebook.  
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Посилання на поточні додатки 
Додайте посилання на файл, який ви зберегли у панелі Додатки. 
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Розпізнавання рукописного написання 
Якщо ви щось написали ручкою у програмі SMART Notebook, існує можливість розпізнавання 
написаного і конвертування в текст. Цей інструмент здебільшого використовується при роботі на 
інтерактивній дошці, але також застосовується і у викладанні при створенні уроків на комп'ютері.   
 
Щоб конвертувати слово, написане вручну, в текст, натисніть випадаюче меню об'єкта і оберіть ваше 
слово зі списку.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Порада: Ви можете розпізнавати слова різними мовами. Просто оберіть іншу мову за замовчуванням 
зі списку.  
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Розпізнавання фігур 
Розпізнавання фігур працює так само, як і розпізнавання рукописного почерку. Фігури також можна 
розпізнавати як літери і цифри. 
 
Якщо ви малюєте фігуру за допомогою ручки, ви можете зайти у випадаюче меню об'єкта, 
коли фігура виділена, і обрати Recognize Shape (Розпізнати фігуру), щоб конвертувати її у 
фігуру. Ви також можете скористатися Shape Pen з панелі інструментів SMART Notebook, щоб 
одразу малювати фігури.  
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Друкований текст 
Щоб додати друкований текст як об'єкт у файл SMART Notebook, просто надрукуйте на клавіатурі і 
натисніть Enter, коли закінчите.  
 
Панель інструментів Шрифти з'являється, коли ви друкуєте або після того, як ви натисните на значок 
текстового об'єкта на панелі інструментів програми SMART Notebook і натисните на робочій ділянці. 
Використовуйте її для зміни таких властивостей, як шрифт, розмір, стиль шрифту, вирівнювання, 
обертання, список, нижній та верхній індекс, математичні символи і перевірка правопису. Ви також 
можете швидко змінити ваш шрифт, натиснувши на одну з опцій у підменю текстового об'єкта.  
 
         Значок текстового об'єкта  
 
 
 
 
 
 
Підменю текстового об'єкта 
 
 

Назва шрифту  Розмір шрифту  Стиль шрифту  Обертання 
Колір шрифту   Список   Математичні символи  
    

 
 

Перевірка правопису 
 
 
 
 

  Вирівнювання Нижній або верхній індекс  

 
 
 
 
 
 
          Математичні символи 

 
 
 
 

 
 
Список      Перевернутий текст
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Перевірка правопису 
 
 
 
 
 
 
 
 
 
 
Натисніть Check Spelling (Перевірка правопису) з випадаючого меню, щоб перевірити правопис 
текстового об'єкта. 
 
З'явиться діалогове вікно Spelling Check (Перевірка правопису) з варіантами правопису, якщо правопис 
обраного текстового об'єкту неправильний. Оберіть правильний правопис текстового об'єкта з 
запропонованого списку і натисніть кнопку Change (Змінити), щоб виправити слово, написане 
неправильно.  
 

 
 
Коли Перевірка правопису увімкнена на панелі інструментів, впевніться, що ви натиснули клавішу 
пробілу в кінці слова. Ця дія означає, що ви завершили друкувати, і Перевірка правопису може 
розпочинатися.
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Коли ви увімкнули перевірку правопису, слова, написані неправильно, будуть підкреслюватися 
червоним, одразу ж після того, як ви їх друкуєте.  
 
 
   
 
 
 
 
 
  Перевірка правопису вимкнута 
 
 
 
 
 
 
 
 
 
 
 
  Перевірка правопису увімкнена 
 
 
 

Щоб перевірити правопис усіх текстових об'єктів у вашому файлі, натисніть на будь-якому текстовому 
об'єкті, щоб виділити його, і з випадаючого меню натисніть Check Spelling. Програма SMART Notebook 
перевірить правопис цього слова, а потім запитає, чи бажаєте ви перевірити решту документа. Коли 
перевірка правопису завершиться, ви отримаєте повідомлення. 
 
 
 

Інструменти для малювання 
Використовуйте інструменти для малювання, які можна знайти на 
панелі інструментів програми SMART Notebook, щоб створювати 
ваші власні об'єкти.  
 

Інструменти Ручка і Гумка для стирання 
Використовуйте мишу, щоб створити об'єкти за допомогою інструментів Ручка, Creative Pen або Shape 
Pen. 
 
 
 
 
 
 
 

Однакові об'єкти, намальовані  
трьома різними ручками: Pen,  
Creative Pen, Shape Pen 

 
 

Частина об'єкта 
інструмента Creative, 
стерта інструментом 
Гумка для стирання 

 

Інструмент Гумка для стирання стирає усе, що ви створили інструментом ручок. Коли ви стираєте 
частину об'єкта, властивості частини, що залишилася, можна змінювати незалежно від іншої. 
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Інструмент Лінія 
Натисніть кнопку Line (Лінія) на панелі інструментів програми SMART Notebook, щоб намалювати прямі 
лінії. Виділіть будь-яку лінію, зроблену за допомогою інструменту Лінія, і потягніть кінцеві точки, щоб 
розтягти її або змінити кут. Утримуйте клавішу Shift під час маніпуляцій з лінією, і лінія зупинятиметься 
на місці кожні 45

о
. 

 
 

      
  Потягніть 

 
 
 
 
 
Інструмент Фігури  
Покращуйте будь-яке завдання за допомогою інструмента Фігури на панелі інструментів програми 
SMART Notebook.  

 
Створіть фігуру 

 

 
 
 
Коли ви натискаєте на значок Фігури, з'являється меню з фігурами. Натисніть на фігуру, яку ви хочете 
використати, і розмістіть ваш курсор на сторінці, де б ви хотіли створити фігуру. Утримуйте ліву кнопку 
миші і потягніть ваш курсор, поки фігура не отримає потрібної форми. Щоб намалювати ідеальну 
фігуру, утримуйте клавішу Shift під час малювання фігури.  

 
Після того, як фігура з'явилася на вашій сторінці SMART Notebook, її 
можна змінювати так само, як інші об'єкти, за допомогою точки обертання, 
точки зміни розміру або випадаючого меню.   
 
Якщо ви натиснете на значок інструменту Select (Виділити), а потім двічі 
натиснете на фігуру, з'явиться текстове вікно, і ви зможете  додати до 
вашої фігури напис. 

 
 

Інструмент Заливка 
Будь-яку фігуру можна швидко залити кольором, розмістивши баночку з фарбою на об'єкті 
фігури. Колір заливки буде таким, яким є останній колір, обраний з палітри кольорів. Щоб 
змінити колір банки з фарбою, натисніть на значок фігури, натисніть на банку з фарбою, 

натисніть на панель Властивості і оберіть колір з палітри кольорів.  
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Вставляння зображень у програмі SMART Notebook  
Щоб додати зображення до файлу SMART Notebook, використайте меню Вставити, щоб імпортувати 
графіку або кліп-арт з іншого місця розташування на вашому комп'ютері.  
 

Захоплення інформації 
Панель інструментів Захоплення екрану (Screen Capture) дозволяє захопити зображення, як, 
наприклад, цифрове фото з Інтернету, у сторінку SMART Notebook. Щоб отримати доступ до панелі 
інструментів Захоплення екрану, натисніть на значок Screen Capture (камера) на панелі інструментів 
програми SMART Notebook. Не забувайте про повагу до авторських прав. 
 

Кнопка Як вона використовується 

 Утримуйте ліву кнопку миші і перетягніть, щоб окреслити прямокутну ділянку, яку ви 
хочете захопити. Відпустіть ліву кнопку миші після того, як ділянка виділена. 

 Натисніть на вікно, яке ви хочете захопити. Відпустіть ліву кнопку миші після того, як 
потрібне вікно з'явиться у ділянці. 

 Перейдіть до екрану, який ви хочете захопити, і натисніть кнопку для захоплення цілого 
екрану. 

 Натисніть і потягніть, щоб утворити довільну фігуру навколо ділянки, яку ви хочете 
захопити. Відпустіть ліву кнопку миші після того, як ділянка виділена. 
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Питання для перевірки: Об'єкти у програмі SMART Notebook  
 
1. Позначте точку для обертання, точку для зміни розміру і випадаюче меню на об'єкті, 
зображеному нижче. 
 

 
 
2. Опишіть, як пересунути об'єкт з однієї сторінки SMART Notebook на іншу. 
 
 
 
 
3. Для чого ви б могли додати посилання в об'єкті, що виведе вам на іншу сторінку у вашому 
файлі SMART Notebook? 
 
 
 
 
 
 
 
4. У чому різниця між Send to Back (Відправити позаду) і Send to Backward (Відправити назад) 
при зміні порядку об'єктів? 
 
 
 
 
 
5. Як перевірити правопис у файлі SMART Notebook? 
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Відповіді для перевірки: Об'єкти у програмі SMART Notebook  
 
1. Позначте точку для обертання, точку для зміни розміру і випадаюче меню на об'єкті, зображеному 
нижче. 
 
   Точка для обертання     

Випадаюче меню 
 
 
 
 
 
 
 
   Точка для зміни розміру 

 
 
 
2. Опишіть, як пересунути об'єкт з однієї сторінки SMART Notebook на іншу. 
 
 Щоб змінити об'єкт, перетягніть його з робочої ділянки в ескіз сторінки у Сортуванні 
 сторінок. 
 
 
3. Для чого ви б могли додати посилання в об'єкті, що виведе вам на іншу сторінку у вашому файлі 
SMART Notebook? 
 
 Ви можете використовувати цей вид посилання, коли задаєте питання у програмі SMART 
 Notebook. Наприклад, ви можете поставити питання, потім попросити учня обрати одну з 
 відповідей. Об'єкт, що містить правильну відповідь, може мати посилання на призовий 
екран.  Об'єкти, які містять неправильні питання, можуть мати посилання на екран з об'єктом, що 
 заохочує учня спробувати ще раз.  
 
  
 
4. У чому різниця між Send to Back (Відправити позаду) і Send to Backward (Відправити назад) при 
зміні порядку об'єктів? 
 
  Send to Backward змінює порядок по одному шару за раз.  Send to Back відправляє об'єкт на 
 самий низ стопки об'єктів.  
 
 
 
5. Як перевірити правопис у файлі SMART Notebook? 
 
 На панелі інструментів шрифтів оберіть значок Перевірки правопису. З випадаючого меню 
 об'єкта , оберіть Перевірка правопису. 
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Практичне завдання: Об'єкти в програмі SMART Notebook  
 
1. Запустити програму SMART Notebook двічі натиснувши на значок SMART Notebook на 
робочому столі. Відкрийте новий файл. 
 
2. Встановіть Позначки вирівнювання (Format > Alignment). Натисніть на всі опції для їхньої 
активації. Натисніть ОК. З'являться тонкі лінії, що позначають горизонтальні і вертикальні центри 
сторінки. Перша сторінка є активною сторінкою. Збережіть ваш файл.  
 
3. Створіть текстове вікно, що містить ваше ім'я. У випадаючому меню натисніть на Infinite 
Cloner. З оригінального текстового вікна, перетягніть п'ять копій вашого імені у різні місця на сторінці. 
Вимкніть Нескінченне клонування, натиснувши на оригінал правою кнопкою миші і натиснувши на 
напис Infinite Cloner, щоб прибрати позначку.  
 

 
 
4. Вирівняйте три ваших імені, потягнувши їх. 
 

Примітка: При увімкнених позначках вирівнювання з'являються решітки, щоб допомогти вас вирівняти 
об'єкти вертикально і горизонтально.  
 

 
 



 86 

5. Утримуйте ліву кнопку миші і потягніть, щоб виділити усі три імені. Натисніть на одному з 
випадаючих меню і натисніть Grouping > Group. Тепер три об'єкти стали одним. 
 

 
 
6. Натисніть на випадаючому меню і оберіть Locking > Lock in Place. Тепер об'єкт заблокований 
і не його не можна рухати. Якщо ви хочете розблокувати об'єкт, у панелі Меню натисніть Edit > Select 
All Locked Nodes. Потім натисніть на заблокований значок і натисніть Unlock. Збережіть ваш файл.  
 

 
 

     
 Значок блокування 
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7. Натисніть на значок Add Page, щоб додати іншу сторінку. Тепер ви перебуваєте на 
новоствореній чистій другій сторінці. Знайдіть графіку з Галереї і перетягніть її на сторінку. Зробіть 
графіку більшою, потягнувши за біле коло. Поверніть графіку, потягнувши за темне коло. Збережіть 
ваш файл. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Натисніть на графіку і з випадаючого меню натисніть Copy. Додайте сторінку. У панелі меню 
натисніть Edit > Paste. Натисніть на графіку і у випадаючому меню натисніть Flip > Up/Down. 
Збережіть ваш файл. 
 

 
 
 
 
 
 
 
9. Додайте іншу сторінку. Натисніть значок Text Box і додайте чотири текстових вікна, що містять 
слова hellp, bekaus, recieve і elefant. Натисніть значок Select і натисніть на одному зі слів. У 
випадаючому меню натисніть Check Spelling. Виправте правопис чотирьох ваших слів. Збережіть свій 
файл.  
 

 
 
10. Натисніть значок Add Page, щоб додати іншу сторінку. Тепер ви на новоствореній порожній 
п'ятій сторінці. Натисніть на значок Text Box, увімкніть перевірку правопису, натиснувши на значок. 
Додайте чотири текстових вікна, що містять слова  hellp, bekaus, recieve і elefant.  Щоб перевірка 
правопис здійснювалася автоматично, вам слід натиснути клавішу пробілу в кінці слова, щоб 
позначити кінець слова. Якщо ви не знаєте правильне написання, можете натиснути правою кнопкою 
миші на слово для варіантів. Збережіть свій файл. 
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11. Натисніть на значок Add Page, щоб додати іншу сторінку. Ви тепер на новоствореній шостій 
сторінці. Натисніть на значок Create Shape і намалюйте чотири фігури різних розмірів. Пам'ятайте, 
якщо хочете намалювати ідеальні кола, тримайте клавішу Shift під час малювання. Натисніть на 
панель Властивості. Залийте кожне коло різним кольором. Попрактикуйтеся у розташуванні ваших 
об'єктів у певному порядку, пересуваючи їх так, щоб вони находили один на одного, а потім 
відправляючи об'єкти наперед або назад. Збережіть ваш файл. 
 

 
 
12. Поділіться вашими результатами з колегами. Закрийте програму SMART Notebook, натиснувши 
на File > Exit.  
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Створення 
інтерактивних 
завдань для уроків 
 
З чого мені почати створення завдання 
для уроку для інтерактивної дошки SMART 
Board?  
 
Інструменти програми SMART Notebook включають функції, які допоможуть вам використовувати 
інтерактивну дошку більш ефективно і дозволить вам створювати цікаві, інтерактивні і динамічні 
завдання для уроків у класі.  
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Створення інтерактивних завдань для уроків  
 
Цей розділ має стати путівником з найкращих практик для створення і презентації завдань 
для уроків з використанням програми SMART Notebook.  
 
Ви вже знаєте основи програми SMART Notebook, зокрема як писати у робочій ділянці, як 
додати нові сторінки до вашого файлу SMART Notebook, як переходити з однієї сторінки на іншу і як 
виділяти і пересувати на сторінці SMART Notebook. 
 
Щоб повторити основи роботи з інтерактивною дошкою SMART Board і програмою SMART Notebook, 
відвідайте навчальний центр SMART за адресою www.smarttech.com/trainingcenter.  
 
Перед тим, як прочитати решту цього робочого зошита, переконайтеся, що на вашому комп'ютері 
встановлена остання версія програми SMART Notebook з www.smarttech.com/support/software. 

 
Огляд основ дизайну 
Завдання для уроків повинні розроблятися з оглядом на контент і презентацію. Інтерактивна дошка 
SMART Board — це візуальний і інтерактивний медіум. Знаючи трохи про дизайн і найкращі практики 
щодо того, як інтегрувати інтерактивність за допомогою програми SMART Notebook, ви зможете 
створити завдання для  уроків, які відповідають цілям навчання і заохочують учнів. Створення контенту 
у програмі SMART Notebook з розумінням того, що його слід буде презентувати у класі, забезпечить  
успішне проведення вашого уроку.  
 

    Контент ---> Презентація  
 
Після того, як ви визначилися, який контент ви будете викладати, створіть титульну сторінку і напишіть 
ваші нотатки викладача на початку завдання для уроку. Титульні сторінки і нотатки вчителів 
зосереджені на цілях навчання і надають вадливу інформацію усім іншим вчителям, хто 
користуватиметься цим уроком. Ви можете побачити приклади, як інші викладачі це створювали, 
завантаживши будь-яке завдання для уроку з веб-сайту освітніх рішень 
www.education.smarttech.com/ste/en-US/Ed+Resource. 
 
 

Встановіть параметри для вашої сторінки  
Після того, як у вас з'явилася для завдання для уроку в програмі SMART Notebook, вам потрібно 
почати створювати вашу сторінку.  Одна з перших речей, які вам слід вирішити, це колір тла. 
 
При виборі кольору пам'ятайте, що занадто яскраві або насичені кольори можуть відволікати і 
відвертати увагу від вмісту сторінки на тло. Яскравий жовтий може здатися гарним варіантом, але він 
також може відволікати від інших елементів на вашій сторінці. Залиште найбільш яскраві кольори для   
окремих об'єктів на вашій сторінці SMART Notebook, до яких ви хочете привернути увагу учнів.
 

http://www.smarttech.com/trainingcenter
http://www.smarttech.com/support/software
http://www.education.smarttech.com/ste/en-US/Ed+Resource
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Оберіть колір тла, обравши Format > Background (Формат > Тло) в меню програми SMART Notebook. 
Запуститься палітра кольорів, з яких ви зможете обрати фоновий колір для вашої сторінки SMART 
Notebook.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Робота зі шрифтами в програмі SMART Notebook  
Далі вам потрібно обрати шрифти, які ви хочете використовувати для решти вашого завдання для 
уроку. Одним способом встановити шрифт є виділити ваш текст і скористатися функціями, доступними 
з панелі інструментів Шрифти. Панель інструментів Шрифти з'являється, коли ви друкуєте на сторінці 
SMART Notebook, або після того, як ви двічі натиснете на текстовий об'єкт.  
 

Розмір шрифт  Колір шрифту   Перевірка орфографії 

 
 

 
 
Шрифт 

 
Стиль шрифту 

 
 
Якщо можливо, намагайтеся використовувати лише один шрифт протягом усього завдання для уроку. 
Занадто багато шрифтів можуть відволікати і відвертати увагу від важливих моментів. 
 
Основні правила для вибору шрифтів для вашого уроку в програмі SMART Noteboo включають 
наступне: 
 

 Заголовки мають бути щонайменше 28 кеглем і виділятися жирним. 

 Текст у реченнях і абзацах має бути щонайменше 22 кеглем і бути простим (не жирний і не 
курсив). 

 Переконайтеся, що колір шрифту, який ви обрали, легко читається і його видно на фоновому 
кольорі, який ви обрали. 

  
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Математичні і наукові символи 
Викладачам математики і науки для написання рівнянь і формул у нагоді стануть математичні і наукові 
символи. При натисканні значка Math and Science (Математика і наука) відкривається серія підменю. 
Після натискання на кожному підменю відкривається нова серія варіантів вибору. Натисніть на вашому 
варіанті вибору, що вставити цей символ у ваше текстове вікно.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Натисніть на символи Математика і наука, щоб відкрити підменю математики і науки 
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Додавання інтерактивності  
 

Однією з переваг програми SMART Notebook є можливість змінювати об'єкти на сторінці. Цей розділ 
зосередиться на деяких різних способах, якими можна залучити учнів, шляхом розробки планів 
інтерактивних уроків. 
 

Відкриття  
Один з найшвидших способів додати інтерактивності до завдання для уроку є сховати відповідь на 
питання позаду об'єкта на сторінці SMART Notebook. Інформація, розміщена нижче, надасть вам 
чотири різних способи, які ви зможете використовувати, щоб створювати завдання з відкриванням, які 
легко можна інтегрувати у будь-який навчальний план.  
 
 
Пересунути і показати 
Один зі способів створити завдання з відкриванням — це сховати відповідь за іншим об'єктом.  
 
1. Надрукуйте ваше питання і відповідь. 
2. Намалюйте прямокутник і залийте його кольором, щоб сховати відповідь. 
3. Натисніть двічі на фігуру, щоб отримати змогу додати до неї текст — переконайтеся, щоб ваг 
текст був іншого кольору, аніж прямокутник. 
4. Надрукуйте Відсуньте прямокутник, щоб відкрити відповідь — ви додаєте інструкції до 
фігури, щоб учні, інші співробітники факультету або викладачі на заміні могли працювати з файлом. 
Без інструкцій інші можуть подумати, що вони повинні написати відповідь на фігурі, замість того, щоб 
відсунути її і відкрити відповідь. 
 

Порада: Гарною практикою є обрати Order > Bring to Front (Порядок > Відправити попереду) з 

випадаючого меню на будь-якому об'єкті, який ви використовуватимете для прикриття відповіді. Ця дія 
забезпечить, що ваші учні не побачать відповідь до того, як настане час її відкрити.   

 
 
5. Відсуньте фігуру, щоб відкрити відповідь 
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Стерти і відкрити 
Іншим способом відкрити інформацію можна за допомогою інструмента Гумка для стирання. 
 
1. Надрукуйте ваше питання і відповідь. Скористайтеся ручкою, щоб приховати відповідь 
цифровим чорнилом. 
2. Натисніть на інструменті ручок. Оберіть колір ручки таки самим, як і тло сторінки. Наприклад, 
якщо тло сторінки є білим, тоді цифрове чорнило також має бути білим. 
3. Натисніть на інструмент Гумка для стирання і зітріть цифрове чорнило, що вкриває відповідь. 
Інструмент Гумка для стирання зітре лише об'єкти, створені за допомогою цифрового чорнила. Щось, 
що надруковане на клавіатурі, не можна стерти інструментом Гумка для стирання. 
 

Порада: Ви можете додати інструкції, щоб повідомити класу або іншим викладачам, що все, що їм 
треба зробити, - це скористатися гумкою.  
 

 
 
  До    Після 

 
Впорядкувати і відкрити 
Інший спосіб відкрити інформацію — це шляхом впорядкування об'єктів. 
 
1. Створіть об'єкт. 
2. Створіть другий великий цільний об'єкт. 
3. Посуньте більший об'єкт зверху меншого об'єкта, який потрібно приховати. 
4. Коли прийшов час відкрити менший об'єкт, ви можете відсунути вбік більший об'єкт або змінити 
порядок більшого об'єкта, відправивши його позаду. 
 

Порада: Ви можете додати інструкції, щоб повідомити класу або іншим викладачам, що все, що їм 
треба зробити, - це посунути об'єкт. 
 

 
  Жовте коло накриває червоне коло  Жовте коло відправлене позаду
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Затінення екрану і відкриття 
Четвертий спосіб, як можна відкрити інформацію, - за допомогою інструменту Затінення екрану. 
 
1. Надрукуйте ваше питання і відповідь. 
2. Натисніть на кнопку Screen Shade на панелі інструментів програми SMART Notebook. 
3. Розтягніть Затінення екрану, щоб була закрита лише відповідь на ваше питання. 
4. Коли ви готові, потягніть Затінення екрану, щоб воно більше не ховало відповідь. Ця дія схожа 
на використання паперу для закриття відповіді, яку показують на проекторі. 
 

Порада: При відкритті файлу SMART Notebook, Затінення екрану вкриватиме ту саму ділянку, яку 
воно приховувало, і ви зможете почати обговорення контенту вашого файлу з місця, на якому ви 
зупинилися. 
 
 
 
 
 
 
 
 
  До      Після 
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Ідентифікувати і позначити 
Перетягнути і відпустити 
Завдання ―Потягніть і відпустіть ‖ - це чудовий спосіб визначити, чи ваш клас зміг досягнути певних 
навчальних цілей. 
 
Щоб створити завдання з позначеннями ―Потягніть і відпустіть ‖,додайте об'єкт, який ви хочете 
позначити до робочої ділянки. Об'єкт може походити з Галереї SMART Notebook, Моєї поточної ділянки 
або це може бути графіка, яку ви імпортували, використовуючи меню Вставити. Скористайтеся 
випадаючим меню об'єкта, щоб заблокувати на місці об'єкт, який потрібно позначити. Ця дія 
забезпечує, що об'єкт випадково не посунуть під час уроку. 
 
Далі зробіть позначки (назви) для вашої діаграми і вишикуйте їх унизу сторінки SMART Notebook. Потім 
ви можете попросити когось з класу перетягнути позначки на відповідні ділянки на графіці.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Перетягніть назви до відповідних частин діаграми
 

 



 97 

 

 

 

 

Ви можете додати посилання на об'єкт, наприклад, як на діаграму травної системи, зображену вище, 
на іншу сторінку SMART Notebook з відповідями на питання. Ця сторінка допоможе усім, з ким ви 
ділитеся файлом, знайти правильній відповіді. 
 
Завдання ―Перетягніть і відпустіть ― можна також використовувати в уроках, основаних на текстах. 
Наприклад, ви можете перетягнути певні дати на шкалі часу, визначити серію слів або сполучити 
інформацію. 
 

 
 
 

Нескінченне клонування 
Нескінченне клонування допомагає відтворити об'єкт необмежену кількість разів, без потреби обирати 
Клонування повторно з випадаючого меню. Нескінченне клонування також допомагає зберігати розмір 
вашого файлу SMART Notebook меншим, аніж якщо б ви копіювали і вставляли ту саму інформацію, 
що робить файл простішим для надсилання вашим колегам. 
 
Щоб клонувати об'єкт необмежену кількість разів, виконайте наступні дії: 
 
1. Натисніть на об'єкт 
2. Натисніть на випадаюче меню об'єкта 
3. Натисніть на Infinite Cloner  
4. Натисніть на об'єкт, потім потягніть, щоб створити ідентичний об'єкт.  
 
 
 
 
 

Натисніть і потягніть, щоб створити ідентичний об'єкт  

 
Використання одного об'єкта багато разів 
Однією з переваг функції Нескінченне клонування є можливість створювати завдання ―Потягніть і 
відпустіть‖, не руйнуючи сукупність можливих варіацій щоразу, коли на питання дається правильна 
відповідь. 
 
 
 
 
 
 
 
 
 
 
 
 
Встановіть кожну цифру на рядку цифр у   Використовуйте одну й ту саму цифру 
 положення Нескінченного клонування   для відповіді на питання безліч разів  
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Молодші учні “заповнюють пропуски” нескінченно клонованими записами, або на пустих 
нотних листках створюють пісні, які грають інші однокласники 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Потягніть і відпустіть символ і класифікацію  
відповідних елементів — Метал, Не метал,  
Благородний газ є нескінченними клонами,  
щоб їх можна було використовувати повторно. 
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Тримаємо інформацію в 
контексті 
Іншою перевагою функції Нескінченне 
клонування є те, що завдяки цьому просто 
тримати інформацію в контексті. Ця 
функція особливо корисна для уроків, 
основаних на тексті. 
 
Встановіть кожну літеру слова в 
Нескінченне клонування. Потягніть літеру 
на іншу ділянку вашої сторінки, щоб 
створити анаграми. Початкове слово 
залишиться на місці.  
 
Ви можете встановити таймер, щоб ускладнити урок. Інтерактивний таймер є в колекції Галереї.  
 
 

Magic Pen (Чарівна ручка) 
  Значок Magic Pen на панелі інструментів програми SMART Notebook дозволяє виділяти 
  частини вашої сторінки SMART Notebook, подібно до інструменту Прожектор (Spotlight)  
  в інтерактивній дошці SMART Board.
  
 

Прожектор Magic Pen 
Натисніть на значок Magic Pen на панелі інструментів SMART Notebook для її активації. 
 
Намалюйте кругу фігуру на частині робочої ділянки, яку ви бажаєте виділити. 
 
Коли ви рухаєте курсор над чарівною фігурою, він перетворюється а подвійну стрілку. Ця стрілка 
дозволяє робити виділену ділянку більшою або меншою.  
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Збільшення з Magic Pen 
 
Коли ви використовуєте Magic Pen і малюєте прямокутник навколо ділянки у вашій сторінці SMART 
Notebook, це дозволить вам збільшити цю ділянку. 
 

 
 
Коли ваш курсор наближається до чарівної фігури, він перетворюється на долоню. Ця долоня 
допоможе вам пересуватися по чарівній фігурі, щоб збільшити або виділити різні частини. Стрілка з 
двома кінцями дозволить змінити розмір ділянки для збільшення або виділення.  
 
 
 
 
 
 
 
Щоб закрити чарівну фігуру і повернути вашу робочу ділянку до нормального стану, натисніть на Х у 
квадраті. 
 
Коли ви пишете або малюєте за допомогою Magic Pen, чорнило зникає через приблизно 10 секунд. Ця 
функція є чудовим способом тримати вашу робочу ділянку незахаращеною. Це також гарний спосіб 
запропонувати вашому класу послідовні підказки для рішення задач під час роботи із завданням на 
дошці Smart Board. Ви можете використовувати Magic Pen, щоб «розім'яти» клас, погравши у вправи 
на кшталт Зарядки для мозку на час.  
 
Коли активні функції Прожектор і Magic Pen, викладачі можуть писати лише або активувати 
компоненти лише на виділеній ділянці.
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Питання для перевірки: Розробка інтерактивних завдань для уроків 
 
 
 
1. Якими способами можна відкрити відповіді для групи? 
 
 
 
 
 
 
 
 
2. Як можна використовувати Magic Pen? 
 
 
 
 
 
 
 
 
 
 
3. Як отримати доступ до додаткових математичних і наукових символів? 
 
 
 
 
 
 
 
 
 
 
4. Як можна використовувати Нескінченне клонування? 
 
 
 
 
 
 
 
 
 
 
 
 
5. Чому вибір шрифту важливий при створенні файлу SMART Notebook?
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Відповіді для перевірки: Розробка інтерактивних завдань для уроків 
 
 
 
 
1. Якими способами можна відкрити відповіді для групи? 
 
 
 Відсунути і показати 
 Стерти і показати 
 Впорядкувати і показати 
 Затінити екран і показати 
 
 
2. Як можна використовувати Magic Pen? 
 
 Зосередити увагу на одній ділянці у програмі SMART Notebook. 
 
 
 
 
 
3. Як отримати доступ до додаткових математичних і наукових символів? 
 
 Двічі натиснути на друкованому тексті і обрати значок математичних і наукових символів. 
 
 
 
4. Як можна використовувати Нескінченне клонування? 
 
 Для відтворення об'єкта нескінченну кількість разів, наприклад, у завданнях з рахуванням, 
графічних вправах,  іграх з правописом і словами. 
 
 
5. Чому вибір шрифту важливий при створенні файлу SMART Notebook? 
  
 Це дозволяє менше відволікатися, зберігає файл цілісним, надає можливість бачити текст усім 
присутнім.
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Практичне завдання: Розробка інтерактивних завдань для уроків 
 
Підготовка вашого уроку 
Ви підготуєте завдання для уроку географії, що просить учнів сполучити країни Північної Америки і їхні 
прапори. Ви можете використати концепції, описані у цьому практичному завданні, для підготовки і 
презентації уроку і в інших предметах. 
 
1. Відкрийте чистий файл SMART Notebook. 
2. Натисніть на панель Галерея для пошуку або перегляду колекції готових сторінок SMART, кліп-
арту, анімацій Flash та відеофайлів. Для цього прикладу, ви шукаєте прапори Північної Америки. 
 

Порада: Приберіть ―галочку‖ у квадраті Auto-hide, щоб залишити Бокову панель видимою. Ця дія 

забезпечить вам легкий доступ до панелі Сортування сторінок під час підготовки і презентації вашого 
уроку. 
 

3. Надрукуйте ключове слово flags (прапори).  
4. Натисніть на значок Пошук, що виглядає як велика 
лупа, щоб розпочати ваш пошук. 
Натисніть, щоб розпочати пошук 

5. Програма SMART Notebook показує ваш(і) 
результат(и) пошуку як зображення ескізу папки, що 
підходить під ваш критерій. У цьому прикладі, з'явиться 
папка під назвою Flags. 
6. Двічі натисніть на ескіз папки, щоб переглянути її 
вміст. 
7. Прогляньте колекцію Галереї, щоб знайти прапори 
США, Мексики та Канади. Перетягніть кожний прапор у 
робочу ділянку вашого файлу SMART Notebook. Ви можете 
двічі натиснути на зображення ескізу папки, щоб швидко 
додати її до робочої ділянки. 
 
 
 
 
 
 
    Натисніть на ескіз папки двічі, щоб переглянути її вміст. 
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8. Змініть розмір кожного прапору, потягнувши за точку зміни розміру по діагоналі. 
Переконайтеся, щоб прапори буди приблизно одного розміру. 
 
 
 
 
 
 
 
 
 

Розтягніть точку зміни розміру 
об'єкта, щоб змінити його 
розміри. 

 
9. Вирівняйте прапори горизонтально. 
10. Напишіть назву кожної країни іншим кольором. 
11. Натисніть, наприклад, Сполучені Штати (United States) і оберіть відповідний надрукований 
текст з випадаючого меню об'єкта. Конвертуйте також Мексику і Канаду з рукописного напису у 
друкований текст.  
 

 
 
12. Натисніть Clone (Клонувати) у випадаючому меню, щоб зробити копію назви кожної країни. Для 
кожного прапору має бути дві країни. 

 
 
13. Розташуйте назви кожної країни так, щоб один набір назв країн був розміщений по 
вертикальній лінії у робочій ділянці. Перетягніть інші назви країни до прапорів, які їм відповідають. 
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14. Натисніть, наприклад, на прапор Сполучених Штатів і оберіть Order > Bring to Front з 
випадаючого меню об'єкта, щоб накрити назву United States. Виконайте це завдання для прапорів 
Мексики і Канади. 
 

 
 
 
 
 
 
 
 
 
 
 

Прапор США розміщений позаду друкованого тексту Прапор США тепер розміщений попереду 
друкованого тексту 

 

15. Натисніть File > Save, щоб зберегти ваш файл SMART Notebook Дайте вашому файлу SMART 
Notebook назву і оберіть місце розташування, куди ви хочете його зберегти. 
 

Використання вашого уроку у класі 
Відкривши ваш збережений файл SMART Notebook на інтерактивній дошці SMART Board, попросіть 
ваших учнів перетягти назву кожної країни під прапор, що їй відповідає. Після завершення вправи, 
приберіть прапори, щоб відкрити правильні відповіді. 
 

Порада: Оберіть цікаві налаштування з меню Creative Pen для додавання ‖галочок‖ до правильних 

відповідей. 
 
Ви можете додати стільки сторінок до вашого файлу SMART Notebook, скільки вам буде потрібно для 
створення додаткових завдань для уроків, зокрема позначення назв континентів або знаходження 
столиць на регіональних картах. 

 
Підготовка ваших уроків: Додаткові функції 
Ділянка Мій контент у колекції Галереї зарезервована спеціально для об'єктів і уроків, які ви 
імпортували, захопили або створили, як наприклад, урок, підготовку до якого ви щойно завершили. Це 
також гарне місце для збереження об'єктів і уроків, які ви часто використовуєте або якими хочете 
поділитися зі своїми колегами.   
 
1. Відкрийте ваш урок географії. 
2. Натисніть на панель Галерея. За замовчуванням, виділена папка Мій контент. 
3. Натисніть на Мій контент (My Content) у випадаючому меню і оберіть Нову папку (New Folder). 
4.  
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4. Запустіть Екранну клавіатуру і надрукуйте Country Lesson (Урок про країни). Тепер ви створили 
місце, де можете зберігати усі об'єкти, які відносяться до вашого уроку географії. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Створіть нову папку    Ваша нова папка під назвою Country Lesson з'являється під My 
Content 

 
5. Перетягніть кожний прапор і назву країни у вашу нову колекцію Галереї. Вага нова колекція 
Галереї тепер містить дев'ять окремих об'єктів — по одному прапору і двом назвам для кожної країни. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Оберіть панель Сортування сторінок. Вставте чисту сторінку SMART Notebook, 
натиснувши значок Додати чисту сторінку на панелі інструментів SMART Notebook.  
7. З випадаючого меню Фігури на панелі інструментів SMART Notebook оберіть квадрат. 
Розташуйте ваш курсор на лівій стороні вашої робочої ділянки і намалюйте великий 
прямокутник.  
 
 Натисніть на інструмент Вибрати на панелі інструментів SMART Notebook. Залийте 
прямокутник   кольором, обравши прямокутник, потім обравши Властивості з випадаючого меню 
об'єкта.  
 

Порада: Як варіант, ви можете змінити властивості прямокутника за допомогою панелі 
Властивості.
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8. Справа від прямокутника напишіть або надрукуйте Languages: (Мови), а нижче напишіть або 
надрукуйте English, Spanish, English and French. 
 

 
 
9. Натисніть випадаюче меню ескіза сторінки у панелі Сортування сторінок. Оберіть Add Page to 
Gallery, щоб помістити усю сторінку SMART Notebook у ділянку Мій контент у колекціях Галереї. Ця дія 
дає вам швидкий і простий доступ до сторінок SMART Notebook для планування і презентації уроків.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Порада: Назвіть вашу сторінку SMART Notebook Language exercise (Мовна вправа), щоб ви могли 
впорядковувати ваші складові Галереї у конкретні групи. 
 
10. Перетягніть прапор Мексики з ділянки Мій контент у верхній правий куток прямокутника, який 
ви створили у кроці 7. Тепер перетягніть  слово Мексика (Mexico), щоб воно було прямо під прапором. 
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11. Перетягніть сторінку з Мовною вправою, яку ви створили у кроці 10 у робочій ділянці вашого 
файлу SMART Notebook. Ця дія  автоматично вставить нову сторінку SMART Notebook безпосередньо 
після активної сторінки SMART Notebook. 
 
12. Повторіть кроки 11 і 12 з прапорами Канади і США та асоційованим текстом. 
 
13. Натисніть File > Save, щоб зберегти ваш файл SMART Notebook. 
 

Порада: Поділіться вашим уроком географії з іншими колегами за допомогою інтерактивної дошки 
SMART Board у класі. Оберіть Export as Collection File (Експортувати як файл колекції) з випадаючого 
меню Мого контенту, щоб надіслати ваш електронний файл. 
 

Використання вашого уроку в класі 
Запропонуйте вашим учням використати інтерактивну дошку SMART Board, щоб намалювати стрілку 
від назв мов до відповідного прапора за допомогою інструмента Лінія або ручки з полиці для ручок. Ви 
можете сховати правильні питання за прямокутником або прапорами. 
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Дослідіть 
можливості 
 
Чому і коли мені використовувати 
інтерактивну дошку в моєму класі?  
 
Інтерактивні дошки і їхні програми для навчання мають багато сильних сторін у класі. Цей розділ 
пояснює, що таке інтерактивна дошка і які є її переваги над традиційними та іншими цифровими 
медіумами. Також зазначені загальні поради щодо користування. 
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Розуміння інтерактивної дошки 
Кожний бренд інтерактивної дошки працює трохи по-іншому, але у них всіх подібні деякі базові риси. 
Усі інтерактивні дошки отримують інформацію з комп'ютера, а зображення - з певного типу проекційної 
системи, зворотної або фронтальної проекції. У кожної інтерактивної дошки є певні засоби запису, які 
ви натискаєте на екрані. Деякі інтерактивні дошки реєструють тиск вашого дотику на екрані. Інші 
інтерактивні дошки використовують електромагнітну технологію, що міститься у спеціальних маркерах 
і яка читається дошкою. Кілька інших використовують систему з камерою, що бачить, де ваш палець 
або стилус перебувають на дошці. Яким би чином інтерактивна дошка не розпізнавала ваші вхідні дані, 
ця інформація подається назад до комп'ютера, що використовує це введення даних для користування 
цифровою інформацією так само, як це робить натискання на клавіші миші. 
 
Звичайно, усе, що ви робите вашою мишкою на комп'ютерному екрані, на інтерактивній дошці ви 
робите за допомогою пальця або спеціального маркера. 
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Інтерактивна дошка може робити усе, що може робити комп'ютер  

Оскільки  інтерактивна дошка — це лише інший спосіб бачити і контролювати те, що є на вашому 
комп'ютері, ви можете робити на ній усе, що можете робити на комп'ютері, до якого вона приєднана. 
Таке саме програмне забезпечення можна завантажувати, використовувати і зберігати. Можна 
приєднати безпровідну клавіатуру, щоб ви могли друкувати. Ви також можете користуватися 
Інтернетом і програвати відео, звук та інші мультимедійні файли. 
 

Інтерактивні дошки додають вашому комп'ютеру функціональності 
Інтерактивні дошки також додають деякої функціональності вашому комп'ютеру, або радше її додає 
навчальне програмне забезпечення, що постачається разом з вашою інтерактивною дошкою. Усі 
інтерактивні дошки встановлені так, що поверх ваших інших програм або у спеціальній програмі для 
нотаток, що може постачатися разом з вашою інтерактивною дошкою, легко писати або робити 
нотатки. Багато інтерактивних дошок розпізнають текст, який ви пишете і перетворюють його на 
друкований текст. Деякі інтерактивні дошки мають вбудоване програмне забезпечення, що дозволяє 
вводити текст, або малюнки, зроблені вручну, у ваші улюблені програми, як наприклад, програми 
Microsoft Word та Excel.  
 
 

Інтегрувати іншу технологію 
Багато користувачів не знають, що також можна легко використовувати додаткові технології, зокрема 
DVD-плеєри, камери для документів та відеокамери, разом з інтерактивними дошками, так само як з 
телевізором. 
 

Те, що ви можете зробити, залежить від вашого постачальника інтерактивної 
дошки 
Один з найбільших факторів, що відрізняють різноманітні фірми інтерактивних дошок, - це якість 
програмного забезпечення і ресурси для викладання, які вони надають. В обговоренні щодо 
використання інтерактивної дошки в класі, ми матимемо на увазі використання високоякісного 
навчального програмного забезпечення, спеціально розробленого для легкого створення уроків на 
інтерактивній дошці. Через це у даному можуть бути зазначені деякі поради, які ваш бренд або 
інтерактивна дошка не зможуть виконати. 
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Роль інтерактивної дошки у класі 
Інтерактивна дошка з додатковим навчальним забезпеченням має цілий ряд переваг, що робить його 
чудовим інструментом у класі. 
 

Використовуйте інтерактивну дошку для 
наступного: 

Деякі переваги виконання цього на 
інтерактивній дошці: 

- Викладання для цілого класу 
 
- Демонстрація завдання перед тим, як учні 
почнуть працювати самостійно 
 
- Презентація і загальне уявлення про нову тему 
 
- Написання нотаток, які можна зберегти і 
роздрукувати або розмістити на веб-сайті  
 
- Генерація ідей і позначення концепцій 
 
- Огляд і повторення в кінці дня або розділу 
 
- Показ відео і анотацій поверх нього 

- Викладачі можуть бути більш гнучкими у 
презентації матеріалу 
- Учні можуть залучатися до активних класних 
занять 
 
 
- Зображення і відео можна легко інтегрувати 
 
- Минулу роботу можна легко знайти і переглянути 
знову 
 
- Уроки і нотатки можна зберігати і роздруковувати 
 
- Легко переглянути для всіх учнів 
 
- Викладачі можуть зробити більше зі своїми 
уроками для всього класу, потребуючи менше 
часу на підготовку 

 
Деякі вчителі також можуть використовувати інтерактивні дошки і їхнє програмне забезпечення для 
наступного: 
 

 Управління класом (відвідування, відлік часу для перерв) 

 Показ завдання для учнів, яке вони можуть бачити під час роботи на своїх місцях 
 
Інтерактивні дошки також є чудовим інструментом у класі, але, як і всі інші інструменти, їх слід 
використовувати, лише коли це ефективно. Немає потреби і, напевно, й особливої переваги у тому, 
щоб учні весь день проводили перед інтерактивною дошкою. Хоча інтерактивна дошка є чудовим 
інструментом для багатьох завдань у класі, краще варіювати використання інтерактивної дошки з 
іншою діяльністю, так само як ви робили б у класі без інтерактивної дошки.
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Найкращий контент для розгляду на інтерактивній дошці 
Будь-який вид контенту для будь-якого предмету можна розглядати на інтерактивній дошці, але для 
деяких видів діяльності вона підходить краще, ніж для інших. Нижче ви знайдете деякі основні правили 
для початку роботи 
 

Інтерактивна дошка з її навчальним 
програмним забезпеченням є чудовим 
вибором для наступного: 

Інтерактивна дошка погано заміняє наступне: 

- Показ відео — Інтерактивна дошка краща за 
телевізор, оскільки ви можете робити скрін-шоти 
відео і будувати урок навколо них. Ви також 
можете робити паузи і надавати анотації поверх 
відео, щоб виділити інформацію. 
 
- Контент, що є дуже візуальним і який важко 
пояснити без зображень 
 
- Контент, який є занадто небезпечним, 
недоступним або таким, який складно побачити у 
реальному житті 
 
- Написання нотаток до лекцій, які ви можете 
зберегти і надрукувати пізніше. Ця можливість 
також рятує викладачів від потреби чекати, поки 
учні завершать копіювати, щоб стерти дошку і 
продовжити писати. 
 
- Уроки, на яких потрібно робити маніпуляції, як 
наприклад, вправами на класифікацію або задачі з 
рахуванням монет, але коли для того, щоб для 
всього класу побачити справжні об'єкти, 
знадобилося багато часу або це було б дуже 
складно. 
 
- Контент, що є абстрактним, але який ви хочете 
зробити більш конкретним завдяки використанню 
симуляції або анімацій Flash 
 
- Інтерактивне спілкування зі школами або 
гостьовими викладачами в іншій частині світу 

- Справжні наукові експерименти 
 
- Живі візити гостьових викладачів 
 
- Навчальні поїздки у доступні місця 
 
- Мистецтво з використанням справжніх 
матеріалів. Проте, чудово підходить для історії 
мистецтва і теорії мистецтва. 
 
- Музика з використанням справжніх інструментів, 
але є чудовим для теорії і історії. 
 
- Індивідуальне використання об'єктів для 
маніпуляцій 
 
- Фізичні дії 
 
- Навчання писати ручкою на папері 
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Розробка уроку 
 
Як створити ефективний урок, 
використовуючи інтерактивну дошку?  
 
Цей розділ досліджує відносини між традиційною практикою викладання і ефективними завданнями, 
розробленими для інтерактивної дошки SMART Board.  
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Основи викладацького дизайну 
Планування будь-якого завдання для уроку має на увазі розуміння того, який контент ви хочете, щоб 
ваші учні дослідили, і які подати цей контент таким чином, щоб він був інформативним, залучав учнів і 
ефективно ефективно допомагав учням засвоїти матеріал. Сьогоднішні класи різні і не прості. Гарні 
викладачі беруть до уваги багато факторів, розробляючи свої уроки. Сукупність цих факторів у 
розробці уроків і є те, що ми називаємо, коли використовуємо термін ―викладацький дизайн ‖. 
 

Чим відрізняється викладацький дизайн для інтерактивної дошки? 
Інтерактивна дошка є цифровим, візуальним медіумом, що має багато спільного з екраном та 
цифровим проектором. Частиною того, що відрізняє викладацький дизайн для інтерактивних дошок від 
традиційного викладацького дизайну або планування уроків, є використання цього надзвичайно 
візуальним, цифровим медіумом, не обмежуючись PowerPoint. 
 
Що відрізняє інтерактивну дошку від екрану і цифрового проектора,  це її здатність до інтерактивності. 
Велика частина того, про що йдеться у цьому робочому зошиті, стосується розуміння і використання 
усіх можливостей унікальних переваг, які надає технологія інтерактивних дошок.  
 
Цей розділ має на меті відобразити найкращі практики, вже вам відомі, і ввести їх у розробку уроку, 
через призму використання інтерактивної дошки. Базові знання про дизайн для візуального медіуму і 
деякі найкращі практики стосовно інтеграції переваг інтерактивної дошки у ваші уроки, допоможе вам  
створити цікаві, інформативні завдання для уроків, що відповідають меті навчального плану. 
 
Будуть описано наступні принципи гарного дизайну уроків, відповідно до їх використання в уроках на 
інтерактивній дошці: 
 

 Зрозуміло донести зміст 

 Врахувати вік та рівень учнів 

 Надати можливість активної участі учнів 

 Підходити для різних стилів викладання 

 Врахувати особливі потреби 

 Залучити учнів до іншої діяльності 

 Заохотити подальше зацікавлення 

 Зробити можливим оцінювання досягнення цілей навчання 

 Зробити можливим повторення і огляд 
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Зрозуміло донести зміст  
Зрозуміле подання змісту стає надзвичайно візуальним питанням під час презентації уроку на 
інтерактивній дошці.  Щоб чітко донести інформацію, вам слід прибрати те, що відволікає увагу, 
упевнитися, що текст легко читається, а завдання для уроків мають чіткі пояснення. Наступний розділ 
допоможе вам розпочати розробку зрозумілих, привабливих уроків. 
 

Створіть титульну сторінку для вашого уроку  
Після того, як ви визначилися щодо змісту вашого уроку, створіть титульну сторінку і включіть секцію з 
нотатками викладача на початку вашого завдання для уроку. Титульні сторінки і нотатки викладача 
зосереджуються на меті навчання і надають важливу інформацію для викладача на заміні аьр інших 
викладачів, які можуть також використовувати ці завдання для уроку. 
 

Поміркуйте щодо фонового кольору 
Обираючи фоновий колір, пам'ятайте , що занадто яскраві або насичені кольори можуть відволікати і 
відвертати увагу від вмісту сторінки на тло. Яскравий жовтий може здатися гарним варіантом, але він 
також може відволікати від інших елементів на вашій сторінці. Залиште найбільш яскраві кольори для   
окремих об'єктів на вашій сторінці SMART Notebook, до яких ви хочете привернути увагу учнів. 
 
Хоча біле тло є типовим варіантом за замовчуванням, можливо, кращим варіантом буде обрати для 
тла вашого уроку кремовий або пастельний колір. Яскравий білий колір відбиває бліки і може бути 
неприємним для очей деяких учнів. 
 

Правильно оберіть шрифти  
Обираючи шрифт, ви обираєте як ваш текст виглядатиме на інтерактивній дошці. У кожного шрифту є 
особистість, і деякі легше читати за інші. Наприклад, Times New Roman, Comic Sans та Arial 
виглядають  дуже по-різному.  

   F     F     F 
  Times New Roman    Comic Sans    Arial 

 
По можливості намагайтеся використовувати один шрифт протягом усього завдання для уроку. 
Забагато шрифтів можуть відволікати і відвертати увагу від важливих моментів. 
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Використовуйте шрифти, які встановлені на вашому комп'ютері інтерактивної 
дошки 
На вашому комп'ютері встановлена невелика кількість шрифтів за замовчуванням. Встановлення 
деяких програм додає більше шрифтів до списку. Нові шрифти також можна обрати і завантажити з 
веб-сайтів, які спеціалізуються на наданні або продажу незвичайних шрифтів. Деякі шрифти є 
особливістю платформ операційних систем Macintosh або Windows, водночас деякі можуть 
використовуватися в обох системах. 
 
У результаті, деякі шрифти є звичними для будь-якого комп'ютера, наприклад, Arial або Times New 
Roman, у той час як інші можуть бути на вашому комп'ютері і більше ніде. Слід бути обережним, 
використовуючи незвичайні, нестандартні шрифти у ваших уроках, щоб не отримати неприємне 
повідомлення про те, що шрифт, який ви використали у прекрасному уроці, який ви створили вдома, 
не знаходиться. Таке трапляється, тому що інформація про шрифт зберігається на кожному комп'ютері 
і програмне забезпечення інтерактивної дошки лише отримує до неї доступ, а не зберігає. Щоб 
уникнути такого ускладнення, використовуйте лише звичні шрифти у розробці вашого уроку. Якщо ви 
знайдете незвичайний шрифт, без якого просто не можете обійтися, встановіть його і на вашому 
домашньому комп'ютері, якщо ви створюєте ваші уроки вдома, і на комп'ютері в класі, який 
використовуватиме інтерактивна дошка. 
 

Ніколи не жертвуйте зрозумілістю заради стиля  
Поміркуйте щодо розміру і кольору тексту, який ви використовуватиме у завданні для вашого уроку. 
Завжди пам'ятайте про учнів на задніх лавах класу. Коли ви створюєте текст на вашому 
персональному комп'ютері, може бути важко сказати, чи він достатньо великий або чіткий. Проектор 
збільшить ваш текст, але існує можливість, що учні не будуть сидіти так близько біля інтерактивної 
дошки, як ви біля екрану свого персонального комп'ютера. Відійдіть від свого комп'ютерного монітору, 
щоб оцінити чіткість або протестуйте ваш урок на інтерактивній дошці. Якщо сумніваєтеся, завжди 
обирайте чіткість, а не стиль. Після того, як ви вирішили, який вигляд матиме ваш текст, 
переконайтеся, що він послідовний, щоб вашо урок плавно переходив з однієї сторінки на іншу.   
 
Основні правила для вибору шрифту для завдання вашого уроку для інтерактивної дошки включають 
наступне: 
 

 Заголовки мають бути щонайменше 28 кеглем і виділятися жирним. 

 Текст у реченнях і абзацах має бути таким самим шрифтом, що й заголовок, 22 кегль і 
звичайним шрифтом (не жирний, не курсив). 

 Переконайтеся, що колір шрифту, який ви обрали, легко читається і його видно на обраному 
вами кольору тла. 
 

Такі шрифти можуть виглядати симпатично, але добре 
подумайте, де їх використовувати. Для заголовків і жартівливих 
ігор підійде, але чи хочете ви повідомити важливий факт таким 
дивним, важким для сприймання шрифтом?  
 
Використовуйте шрифт відповідно до віку 
Читання різних видів друкованого тексту — це вміння, яке розвивається з часом. Для дітей молодших 
класі, які лише навчаються читати і писати, легше буде читати шрифт, де літери більше нагадують 
друковані літери, які їх навчили писати. Маленькі літери друкованого шрифту особливо незрозумілі 
для дуже маленьких дітей. Шрифти з засічками, такі як Times New Roman, також незрозумілі для дітей, 
тому що літери мають іншу форму, ніж ті, які вони друкують у класі. Викладачі дуже маленьких дітей 
можуть знайти ідеальний шрифт, завантаживши шрифт, що дуже нагадує написання друкованих літер 
вручну, з одного з багатьох веб-сайтів, які пропонують шрифти безкоштовно або платно. Проте, якщо 
ви створюєте ваш урок вдома, не забудьте встановити цей шрифт також на вашому на домашньому 
комп'ютері, щоб уникнути помилок з відсутністю шрифту.
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Не бійтеся почати нову сторінку 
Ви можете додати так багато сторінок до файлу SMART Notebook, скільки забажаєте. Для 
максимальної ясності, нехай у вашому уроці буде одна ідея на сторінку. Коли сторінка починає 
заповнюватися змістом, розбийте інформацію на дві простіших, легших для сприймання сторінки.  
 

Поміркуйте над створенням постійних тем 
Однакова структура вашого уроку сторінка за сторінкою дає глядачу можливість зрозуміти, де шукати 
інформацію. Крім того, довільне або непривабливе розташування об'єктів відволікає багатьох глядачів 
від зосередження на вашому важливому змісті. Вам не потрібно бути графічним дизайнером, щоб 
створити урок, що буде зрозумілим і легким для візуального сприйняття. Ось кілька порад. 
 
Заголовки і підзаголовки допомагають визначити тему. 
 
Якщо ви вирішили використовувати кнопки для 
навігації, нехай їхнє розташування буде однаковим 
на  усіх сторінках 
 
 
 
 
Розмір шрифту великий і добре контрастує з 
кольорами тла. 
 
 
 
 
 
Структура проста і приваблива. 
 
Колір використовується стримано і однаково. 
 
 
 
 
 
 
Прості символи позначають тип інформації,  
яку глядач може тут побачити. 

 
 
Після того, як ви створили одну сторінку, якою ви задоволені, скопіюйте або клонуйте цю сторінку і 
використайте її як основу для інших сторінок уроку. Це збереже ваш час, уникнувши потреби 
розміщення об'єктів на кожній сторінці. Це також допоможе, щоб ваша структура не виглядала так, 
наче стрибає, коли ви переходитиме з сторінки на сторінку. 
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Зробіть посилання чіткими і доречними 
Додавання посилання у ваш урок надає комп'ютеру інформацію, яка йому потрібна для того, щоб 
долучити інший документ, іншу сторінку у вашому уроці, відео або веб-сайт в Інтернеті. Деяке 
програмне забезпечення інтерактивних дошок надає вам можливість робити з об'єкта посилання або 
показувати посилання як додатковий значок, активувати який можна одним дотиком. Налаштування 
вашого посилання таким чином, щоб воно активувалося за допомогою дотику об'єкта, корисне для 
створення навігаційних кнопок або створення завдання, коли відкривається призовий екран, якщо 
торкнулися до правильної відповіді. Також це стане у нагоді при налаштуванні вашого тексту як 
посилання, замість окремого посилання поруч з текстом, якщо ви хочете, щоб посилання більше 
нагадувало текстові посилання, як на веб-сторінках.  
 
Який би стиль посилання ви не обрали, переконайтеся, що воно очевидне для будь-якого користувача, 
а не лише для вас, творця. Якщо посилання буде легко помітити, це допоможе вам використати урок 
повторно пізніше. Це також полегшить задачу для викладачів на заміні, учнів або інших, хто 
використовує урок, щоб знайти посилання. Щоб зробити посилання помітним, напишіть перед ним 
вказівку, наприклад, Натисніть тут, щоб подивитися віртуальний тур гробницею Тутанхамона. 
Створіть навігаційні кнопки, що виглядають, як кнопки, і мають на собі текст, що пояснює, що вони 
роблять. Наприклад, назад, на кнопці, що з'єднує з попередньою сторінкою в уроці. Якщо ви зробили 
текст об'єктом посилання, змініть шрифт на синій і підкресліть його. Ця дія також допоможе зробити 
його схожим на більш знайомі текстові посилання веб-сторінок. 
 
Ефективні посилання 
 

Натисніть на зображення, щоб подивитися 
віртуальний тур гробницею Тутанхамона 

                   Зображення, використане як  
                    посилання з вказівкою для 
                    користувача 

 

Відкриття гробниці Тутанхамона Говардом 
Картером у 1922 році вважалося найбільш  

 
Текст, використаний, як об'єкт 
посилання і відформатований так, щоб 
нагадувало звичне текстове посилання 
веб-сторінки 

 

Ефективні навігаційні кнопки, що 
нагадують кнопки і містять текст із 
вказівкою 

Перевірте ваші уроки після того, як ви їх створили, щоб переконатися, що всі посилання ведуть тужи, 
куди вам потрібно. Якщо ви приєднуєте посилання на іншу сторінку у вашому уроці, переконайтеся, що 
кнопка назад (back) повертає туди, звідки ви почали, щоб не збивати хід уроку. Якщо ви 
використовуєте урок, який створив хтось інший або створили ви деякий час тому, було б добре 
перевірити посилання, щоб упевнитися, що вони все ще ведуть на активні веб-сайти. 
 

Використовуйте інтерактивний і мультимедійний контент розсудливо 
Мультимедійні елементи — це популярний спосіб інтегрувати контент у завдання вашого уроку, що 
підходить до різних стилів навчання. Ці інструменти є гарним додатком до будь-якого уроку, але їх слід 
використовувати з деякою обережністю. Наповнення кожної сторінки анімацією, відео та звуком може 
відволікати учнів від навчальної мети і спрямовувати їхнє зосередження на технології замість вмісту 
вашого уроку. 
 
Використовуйте та експериментуйте з усіма інструментами, які є у вашому розпорядженні, але 
впевніться, що ви знаєте, для чого використовуєте певний інструмент — для досягнення навчальної 
мети.
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Враховуйте вік і рівень учнів 
Ефективні вчителі розробляють уроки так, що ті чітко спрямовані на вік і рівень учнів, яким вони 
викладають. Це легше сказати, аніж зробити, тому що зазвичай існує велике розмаїття рівнів і 
здібностей у класі. Крім того, викладач не завжди може правильно визначити скільки базових знань 
група учнів має стосовно певної теми. Цей розділ розкаже про деякі ідеї щодо того, як скористатися 
додатковою гнучкістю викладання на інтерактивній дошці, щоб краще підібрати матеріал згідно зі 
здібностями і попередніми знаннями учнів. 
 

Зробіть нотатки про попередні знання і мету уроку 
Додайте розділ до нотаток викладача на початку вашого уроку, що описує базові знання, які мають 
учні перед початком завдання, а також конкретні навчальні цілі, на які спрямований ваш урок. 
Включення такої інформації у ваш урок допомагає зосередити вашу увагу на цих ідеях під час 
розробки вмісту уроку. Це також надає важливу базову інформацію для викладачів на заміні або будь-
яких інших викладачів, з якими ви хочете поділитися вашими завданнями для уроку. 
 

Скористайтеся перевагою додаткової гнучкості 
Під час планування і побудови уроку може бути необхідним зробити певні здогадки про рівень 
здібностей і попередні знання учнів. Попередні оцінювання перед уроком, зокрема попередні тести та 
чарти KWL (Know, Want to know, Learned – Знаю, Хочу знати, Вивчив), це чудові способи мінімізувати 
здогадки, які вам потрібно буде робити на майбутніх уроках. Такі типи оцінювання перед уроком легко 
можна зробити на інтерактивній дошці і зберегти для подальшого використання в розділі. 
 
Однією з головних переваг використання інтерактивної дошки є їхня гнучкість. Якщо викладач 
посередині уроку розуміє, що неправильно розцінив здібності учнів або попередні знання, він може 
скористатися всесвітньою мережею або контентом від його провайдера інтерактивної дошки=, що 
спонтанно надати базову інформацію для свого уроку. Зробити паузу у вашому запланованому уроці, 
щоб запустити пошукову систему або веб-сайт, який ви попередньо знайшли і приєднали до вашого 
уроку, - це гарний спосіб вивчення і створення основи для теми перед тим, як продовжити урок. Така 
гнучкість уроку не лише забезпечує, що всі учні мають тверде підґрунтя, на якому будувати подальший 
зміст, а й демонструє учням, що вони можуть зробити, якщо не повністю розуміють тему або завдання. 
 

Надайте учням доступ до інформацію поза класом 
Проведення уроку на інтерактивній дошці надає можливість легко надрукувати матеріали уроку або 
розмістити їх на учбовому веб-сайті. Такий підхід робить зміст доступним для учнів, які пропустили 
урок або можуть отримати користь від більш повного доступу до матеріалу. 
 

Врахуйте грамотність 
Якщо учні у вашому класі мають низький рівень писемності, розгляньте можливість використання 
візуальних матеріалів, зокрема зображень, відео або діаграм. Залиште тексту другорядну роль. 
Залучення візуальних матеріалів — це та територія, де використання інтерактивної дошки для 
викладання має головні переваги. При оцінюванні грамотності вашого класу, не забувайте про учнів з 
особливими потребами та учнів, для кого мова викладання не є першою. Використання візуальних 
матеріалів є також гарним способом навчити мовної грамотності, тому що таким чином поєднуються 
слова, які ви говорите і пишете, з візуальним зображенням.  
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Легко диференціюйте викладання 
інтерактивна дошка дозволяє простішу інтеграцію диференційованих стратегій в уроці. Можна 
заздалегідь підготувати і організувати декілька різних рівнів завдань, що дозволить викладачам 
спонтанно обирати таке, що найбільш підходить під час уроку. Викладачі також можуть пропонувати 
різні рівні питань для певних учнів на основі їхніх здібностей таким чином, щоб не було очевидно, що 
деякі учні отримують легші питання. Іншим гарним способом зберігати інформацію різної складності і 
показувати її, коли необхідно, є панелі для перетягування (Pull tabs). Використовуючи стратегію 
―сховати-показати‖ в уроках також дозволяє змінювати рівень складності, тримаючи додаткову 
інформацію прихованою, якщо вона непотрібна.  
 
 Інформація панелі перетягування збережена   Інформація панелі перетягування відкрита 
 

 
 

Викладачі можуть також диференціювати, позначаючи питання на інтерактивній дошці різними 
кольорами відповідно до рівня складності або показуючи різні завдання на інтерактивній дошці для 
самостійної роботи учнів. 
 

Диференціюйте за допомогою запису вашого процесу 
Деякі інтерактивні дошки мають інструмент 
запису, що дозволяє викладачам записати кроки, 
які вони здійснюють на інтерактивній дошці і 
програвати їх для учнів пізніше. Наприклад, 
викладач може увімкнути функцію запису, 
провести клас потрібними кроками для 
розв'язання математичної задачі, зробивши 
приклад на інтерактивній дошці, зупинити функцію 
запису і поставити на повторне програвання для 
класу, поки вони виконують свою роботу. 
 
Використання функції запису дозволяє сильним 
учням зробити свою роботу без того, щоб 
вислуховувати повторні вказівки для всього класу, 
і водночас допомагаючи учням з середніми та 
слабкими здібностями, яким може знадобитися 
звернутися до підказок багато разів під час 
роботи. Якщо до комп'ютера приєднано мікрофон 
під час процесу запису, у файл буде включено 
звук. Супроводжуючий опис процесу словами 
стане у нагоді для розміщення на учбовому веб-
сайті або для надсилання учням, які були відсутні. 
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Зробіть можливою активну участь учнів 
Однією з найбільших переваг викладання на інтерактивній дошці є можливість для учнів і викладачів 
виконувати дії з об'єктами і завданнями на сторінці. Інтерактивність дошки, окрім простих маніпуляцій з 
екраном, дозволяє отримати більш активне навчання. Це означає, що замість поводження з учнями як 
з тими, хто отримує матеріал, і намагання наповнити їх інформацією, учні отримують можливість 
побудувати своє власне значення з запропонованого вами контенту. Багато викладачів вважають, що 
інформація, засвоєна за допомогою активних процесів, легше запам'ятовується і пам'ятається більш 
тривалий період часу, ніж інформація, засвоєна пасивно. Активна участь учнів в уроках також надає 
викладачу можливість оцінити засвоєння матеріалу учнями.  
 
Наступний розділ розглядає пропозиції як розробити уроки на інтерактивній дошці, які роблять 
можливою участь учнів. 
 

Створіть завдання “сховати і відкрити” 

Одним з найшвидших способів для додавання 
інтерактивності уроку є приховати відповідь на 
питання за об'єктом на вашій сторінці 
інтерактивної дошки. Замість надавання учням 
інформації, напишіть питання і сховайте відповідь 
під квадратом або об'єктом, які можна відсунути, 
коли ви будете готові його показати. Як варіант, 
для завдання ―сховати і відкрити‖ можна 
використати інструмент Затінення екрану. 

Який ссавець є найбільшим на землі? 

 

 

Створіть завдання з перетягування і відпускання 
Завдання з перетягування і відпускання є чудовим способом визначити чи зрозумів ваш клас урок. Ці 
завдання добре підходять для вправ з вказанням назв, вправ на сортування, впорядкування, 
рахування і сполучення. Створити завдання з перетягування і відпускання на інтерактивній дошці 
надзвичайно легко, в порівнянні зі створенням вправи на сортування на папері. Для всього класу учнів 
набагато простіше побачити демонстрацію, коли  цей вид завдання виконується на інтерактивній 
дошці, а не зі справжніми предметами, особливо маленькими. Завдання ―перетягнути і відпустити‖ 
заохочують увесь клас до активної роботи і залучають більше частин мозку, тому що задіяні фізичні 
рухи. 
 

 
  Позначення назв на діаграмі є чудовим завданням з перетягування і відпускання 
 

Непоганою ідеєю буде скопіювати ваші завдання уроку з перетягування і відпускання на іншу сторінку 
в кінці вашого уроку, щоб створити підказки з відповідями. Ця сторінка допоможе майбутнім 
користувачам файлу знайти правильні відповіді.  
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Завдання з перетягування і відпускання можна також використовувати для уроків, основаних на тексті. 
Наприклад, ви можете перетягнути певні події на шкалу часу або визначити серію слів.  
 

 
  Використовуйте завдання з перетягування і відпускання, щоб оживити уроки, основані на тексті. 
 

Якщо програмне забезпечення вашої інтерактивної дошки пропонує 
функцію нескінченного клонування, це може стати дуже корисним при 
створенні завдань з перетягування і відпускання. Функція Нескінченне 
клонування дозволяє створювати набір варіантів вибору, з якого учні 
можуть самі здійснювати перетягування стільки разів, скільки потрібно, 
не позбавляючи набір можливих варіантів. 
 
 

Залучіть завдання Flash 
Flash є програмою, що використовується для створення анімаційних 
зображень і інтерактивної графіки. Усі інтерактивні дошки дозволяють 
користувачам переглядати веб-сайти, де учні можуть знайти і виконати 
дії з об'єктами Flash, а деякі провайдери інтерактивних дошок 
постачають навчальний контент Flash, який можна використовувати 
прямо в уроці. Інтерактивні завдання Flash і схожа динамічна графіка 
допомагають дістатися навчальної мети і оживити урок. Знайти об'єкт 
Flash, що доповнить ваш урок, або створити ваш власний, якщо у вас є 
програмне забезпечення Flash і необхідні дані, - це спосіб внести більш 
комплексну інтерактивність до вашого уроку за потребою.  
 
         Використовуйте Нескінченне клонування  
         для позначення графіки, коли потрібно  
         використати однакові елементи більш
         одного разу 

Отримайте і запишіть думку учнів    

 
Залучіть думку учнів, провівши голосування за допомогою інтерактивної системи відповіді, яку деякі 
провайдери інтерактивних дошок продають як додаток до інтерактивної дошки, або просто порахуйте 
голоси на інтерактивній дошці. Опитування думки стимулюють дискусію і дозволяють учням брати 
активну участь в уроках. Збереження вашого файлу зі збереженими результатами голосування 
дозволить підняти ці результати пізніше у розділі, щоб побачити чи змінилися думки щодо питання у 
процесі вивчення теми. 
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Доступно для багатьох стилів навчання 
Термін ―різні стилі навчання‖ стосується теорії про те, що люди від природи більше здатні засвоїти 
матеріал, представлений певним чином. Викладачі часто мають на увазі учнів, які сприймають 
інформацію візуально, на слух або за допомогою кінестетики (рухи тіла).  
Найкращий дизайн уроку - це такий, що враховує і націлений на ряд різноманітних навчальних 
преференцій. Інтерактивні дошки мають унікальну перевагу над екраном і цифровим проектором, 
оскільки завдання на уроках можна виконувати фізично, наприклад, вправу з сортування. Намагайтеся 
залучити якомога більше навчальних стилів на одній сторінці або у завданні, не жертвуючи при цьому 
зрозумілістю, і варіюйте підхід від однієї сторінки до іншої, щоб в одному уроці було дещо для кожного 
навчального стиля.  
У цьому розділі мова йде про способи, якими уроки на інтерактивній дошці допоможуть подати 
матеріал для багатьох навчальних стилів. 
 

Долучити інтерактивний і мультимедійний контент 
Відео та анімаційний контент, створений у Flash, 
можна легко інтегрувати у ваш урок на 
інтерактивній дошці. Відеоконтент можна 
використовувати, щоб дати учням уявлення про 
історичну подію або продемонструвати як щось 
рухається, наприклад, мікроскопічні клітини. 
Контент, створений за допомогою Flash, можна 
використовувати як альтернативу до відео для 
чогось, що не можна зняти на відео, наприклад, 
рух лінії або графіка, або коли ви хочете, щоб 
учні напряму працювали з об'єктом вивчення і 
одразу отримували відгук. Багато учнів краще 
засвоюють матеріал, побачивши щось у дії, аніж 
коли просто чують або читають про це. 
 
Інтерактивний Flash-контент може бути особливо 
цінним для значної частини учнів, яким потрібно 
зрозуміти складні концепції — наприклад, 
математичні концепції, - у контексті, а не 
абстрактно. Викладачі використовують навчальні 
об'єкти Flash, доступ до яких надається їхнім 
провайдером інтерактивної дошки, або з багатьох освітніх веб-сайтів, які надають ці ресурси. 
 

Долучити звук 
Деяке програмне забезпечення для інтерактивної дошки полегшує залучення учнів, які краще 
сприймають на слух, шляхом використання звуку у завданні для уроку. Це також гарний спосіб, щоб 
надати учням більше розуміння щодо особистості спікера, - наприклад, прослухати історичну промову 
може бути більш цікавим для учнів, ніж прочитати її. Іншим шляхом для використання звуку є надати 
швидку реакцію для учнів, коли вони працюють з певними об'єктами на уроці інтерактивної дошки. 
Спробуйте записати аплодисменти для використання при правильних відповідях або слова спробуйте 
ще для неправильних відповідей.  
 
Деякі провайдери інтерактивної дошки надають такі звукові файли користувачам як частину пропозиції 
їхнього освітнього ресурсу. Ви також можете записати звуки або текст з використання цифрового 
рекордера або завантажити звукові файли з Інтернету.  
 

Зробіть урок активним 
Запрошення учнів до інтерактивної дошки, щоб пересунути або сортувати об'єкти, долучає 
кінестетичних учнів. Спостереження з тим, як об'єкти пересувають по інтерактивній дошці залучає 
візуальних і просторових учнів. Інтенсивна комунікація між учнями і викладачем залучає вербальних 
учнів. Усі учні краще засвоюють матеріал від активного стилю, аніж від пасивної обробки інформації. 
Одним словом, якщо ваш урок буде активним і інтерактивним, він більш відповідатиме потребам учнів, 
ніж звичайна лекція.
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Врахуйте особливі потреби 
Залучення освітніх практик зробило сьогоднішні класи дуже розмаїтими. Більшості викладачів слід 
враховувати особливі потреби у класі, наприклад, для тих, хто вивчає англійську, учнів з проблемами у 
навчанні або поведінці і навіть для тих, хто має серйозні вади. Цей розділ розповідає про деякі ідеї, які 
допоможуть вам врахувати особливі потреби у вашому класі при викладанні на інтерактивній дошці.  
 

Отримайте ключовий словник щодо уроку, коли він вам потрібний.  
Ефективна викладацька стратегія для тих ,то вивчає англійську мову, - включити ключовий словник 
для уроку. Ефективним способом для управління словником ключових слів на інтерактивній дошці є 
використання техніки ―сховати і відкрити‖ або панель перетягування (pull-tab). Такий підхід дозволяє 
викладачу звертатися до словника ключових слів на початку кожної сторінки презентації або завдання, 
а потім десь зберегти його для кращого доступу до змісту головної сторінки. Цей вид інтерактивності 
також надає викладачу можливість показувати інформацію лише якщо або коли потрібно. Текст у цій 
панелі словника ключових слів є незалежним об'єктом, - ось чому ви можете його пересувати.  Зібрати 
усі ключові слова у вашому уроці в одну сторінку для роздрукування легко. Учні, які вивчають 
англійську мову або ті, кому важко читати,можуть використовувати список слів для ознайомлення з 
ключовими словами перед уроком. 
 

  Використовуйте панель перетягування, щоб зберегти і отримати доступ 
    до словникової інформації щодо ключових слів уроку  
 

Учні з важкими вадами також отримують користь від використання 
інтерактивної дошки  
Учні з серйозними розумовими і фізичними вадами можуть отримати чимало користі від використання 
інтерактивної дошки. Ці учні можуть навчитися дії і відповіді або фізичній координації. Використовуйте 
програмне забезпечення інтерактивної дошки, щоб розробити таке завдання відповідно до того, що 
подобається конкретному учню. Для деяких учнів поєднання звукового файлу, який грає, коли учень 
щось робить з об'єктом є дуже ефективним. Інші учні можуть краще сприймати нагороду у вигляді 
зображень облич або тварин, анімаційних об'єктів, або змін кольорів. При розробці завдання для 
інтерактивної дошки, пам'ятайте, що деякі учні можуть бути чутливими до бликів, тому як тло вашої 
сторінки використовуйте пастельні кольори, наприклад, бежевий чи блакитний. Деякі учні з важкими 
вадами також потерпають від проблем з зором, тому нехай ваші об'єкти і текст будуть досить 
великими. 
 
Інтерактивні дошки, які відповідають на дотик мають перевагу над тими, які працюють з 
електромагнітною ручкою, коли їх використовують для навчання учням з важкими вадами. Учні, яким 
складно узяти ручку або стилус можуть використовувати інші засоби для написання або навігації по 
сенсорній дошці. Для таких учнів може бути простішим узяти в руку тенісний м'яч, барабанну паличку 
або робити маніпуляції на інтерактивній дошці за допомогою своїх рук. 
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Використання безпровідних указок, щоб долучити учнів з обмеженою 
рухливістю 
Так само, викладачі з учнями, які мають фізичну 
координацію, щоб працювати з дошкою за допомогою 
ручку, але у яких є проблеми з пересуванням, можуть 
спробувати використати безпровідну указку. 
Безпровідні указки є додатковим компонентом, який 
пропонують багато провайдерів інтерактивних дошок. 
Вони дозволяють, щоб інтерактивною дошкою 
контролювали на відстані, що полегшує для учнів з 
низькою або проблемною мобільністю участь у 
завданнях і обговореннях. Безпровідні указки також 
мають багато переваг для усіх учнів і викладачів, 
зокрема це полегшує управління класом і більше 
залучає учнів, коли вчитель може маніпулювати 
завданням уроку з відстані. Безпровідні указки та інші 
інтерактивні технології, які супроводжують 
інтерактивні дошки, будуть описані у розділах нижче. 

Учень користується безпровідною указкою, щоб 
працювати на інтерактивній дошці  

 

Скористайтеся перевагою інструментів, щоб зосередити увагу і надати вказівки 
для учнів 
Деякі інтерактивні дошки мають інструмент затемнення екрану та інструмент підсвітлювання. 
Інструмент Затемнення екрану можна використовувати, щоб допомогти тим, кому важко читати, 
зосередитися на одному рядку або слові у тексті. Пересування затемнення екрану слово за словом 
або униз рядок за рядком може допомогти учню або класу слідкувати за текстом, який вони читають з 
екрану інтерактивної дошки. Такий підхід особливо корисний для тих, хто починає читати, учнів з 
дислексією та іншими навчальними вадами, та учні з проблемами уваги. Як варіант інструмент 
підсвітлювання може допомогти зосередити увагу учнів на певній секції інтерактивної дошки і також 
може використовуватися як допомога в читанні. Деяким учням не подобається інструмент 
підсвітлювання, оскільки вони не можуть бачити виділену інформацію в контексті цілої сторінки. Якщо 
це проблема, зменшення щільності ліхтаря прожектора допоможе зосередити увагу на певному 
елементі в уроці, не втрачаючи контекст цього елементу. 
 

 
Інструмент Затінення екрану можна потягнути вертикально, щоб допомогти слідкувати за текстом рядок за рядком під час 
читання учня. 
 

Використання кольору для допомоги тим, хто починає читати 
Ще одним способом допомогти читачам слідкувати за тим, що ви викладаєте, є позначення кожного 
пункту  іншим кольором. Для деяких учнів також легше говорити про слова червоного кольору в 
питанні до вчителя, ніж казати третій рядок знизу, або ви там щось казали про... 
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Залучіть весь клас 
Під час виконання будь-яких завдань для цілого класу часто виникає проблема як залучити учнів, яких 
не просять узяти учать прямо. Наступний розділ дає кілька порад, як залучити кожного учня до урок на 
інтерактивній дошці. 
 

Загальне обговорення 
Введіть в урок завдання на інтерактивній дошці, які заохочують загальне обговорення у класі. Дуже 
добре допомагають залучити увесь клас ребуси або загадки, а також опитування думки та сценарії з 
дилемами. 
 
Спробуйте використати ребус або загадку, що містить зображення, звуковий кліп або цікаве відео. 
Існує також багато веб-сайтів з ребусами для різноманітного віку і на різноманітні теми. Не потрібно 
шукати додатковий класний час для ребусів і загадок. Пов'яжіть їх з вашим навчальним планом. 
Ребуси або загадки забезпечують гарну підводку до інших завдань уроку і заохочують учнів більше 
замислюватися про матеріал, який вони вивчають. Проведіть мозковий штурм ідей цілим класом, 
записуючи або позначаючи їх на інтерактивній дошці. Навчіть вмінню критично мислити під час 
розв'язання задач, використовуючи інтерактивну дошку для позначення процесу або різних процесів, 
через які проходять учні для пошуку відповіді. 
 

Структуруйте ваші завдання так, щоб вони підходили для різноманітних 
перспектив 
Спробуйте структурувати ваші завдання на інтерактивній дошці так, щоб дозволити багато 
інтерпретацій або мали більше однієї відповіді. Така стратегія дозволяє залучити більше учнів до 
кожного завдання уроку, заохочує обговорення в класі і дебати і навчає учнів тому, що у реальному 
житті часто існує більше одного правильного підходу та рішення. 
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Використовуйте маленькі групи для деяких завдань на інтерактивній дошці  
Залучіть підхід ―подумайте-зберіться у групу-поділіться” або виконайте деякі завдання на 
інтерактивній дошці в маленьких групах. Учні індивідуально або у маленьких групах можуть 
використовувати папір або ноутбуки, якщо ваша школа є однією за багатьох, хто надає мобільні 
ноутбуки для вчителів, щоб залучити до завдань, представлених на інтерактивній дошці. Представник 
від кожної групи може викласти думки групи або рішення на інтерактивній дошці, пояснюючи, як вони 
дійшли такого висновку. 
 
Замініть завдання для усього класу іншими видами роботи 
Замініть завдання на інтерактивній дошці для усього  класу самостійною роботою, роботою в парах 
або невеликих групах. Немає потреби, та й, певно, і користі, від того, щоб проводити увесь день перед 
інтерактивною дошкою. Хоча інтерактивна дошка є чудовим інструментом для багатьох завдань у 
класі, краще розбавляти використання використання інтерактивної дошки для усього класу іншими 
видами діяльності, які дозволять одночасно залучити кожного учня у роботу, так само, як би ви це 
робили без інтерактивної дошки.  
 

Скористайтеся інтерактивною системою реакції 
Деякі провайдери інтерактивної дошки також продають додаткові продукти та програмне 
забезпечення, що називається інтерактивна система реакція (response). Такі системи дозволяють усім 
учням одночасно робити свої внески в уроки на інтерактивній дошці. Викладачі, як використовують 
інтерактивні системи реакції, дають кожному з учнів у руки особисті кнопки, щоб вони могли 
відповідати на тести або опитування, які включені в уроки на інтерактивній дошці. Така можливість 
дуже змінює динаміку роботи для усього класу, оскільки кожний учень має можливість і обов'язок 
брати участь у кожному завданні. Відповіді, які надає кожний учень, можна за бажанням записати для 
пізнішого перегляду і оцінювання викладачем. Результати використання інтерактивної системи реакції 
разом з інтерактивною дошкою допомагають залучити увесь клас, а також одразу зробити оцінку і 
зібрати інформацію для кожного учня. Інтерактивні системи реакції та їхнє використання у класі буде 
розглянуто у наступних розділах.
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Залучіть учнів до інших видів роботи  

Інтерактивні дошки не мають на меті їхнє використання протягом усього дня, для усього, натомість їх 
використовують тоді і таким чином, щоб це приносило користь. Хоча інтерактивні дошки краще 
застосовувати як постійну структуру і інструмент у класі, вони також є чудовим інструментом для 
залучення учнів до інших видів діяльності. Цей розділ пропонує кілька ідея для інтеграції інтерактивних 
дошок в ефективний день у класі. 

 

Не просто пояснюйте, демонструйте 
Інтерактивні дошки відіграють величезну роль у наданні можливостей 
викладачам продемонструвати концепції усьому класу набагато 
зрозуміліше і цікавіше для учнів, ніж якщо вони просто слухали б 
розповідь. Викладач може використовувати інтерактивні дошки для 
показу завдання для усього класу, паралельно з завданнями, над якими 
вони мають працювати самостійно. Таку демонстрацію легко бачать усі 
учні, а слабкі учні мають можливість подивитися на роботу сильніших 
учнів перед тим, як розпочнуть працювати самостійно. У результаті, коли 
діти повертаються до своїх місць для самостійної роботи, більшість 
розуміє, що їх просять зробити і можуть працювати самостійно, що 
дозволяє викладачу підійти до тих учнів, яким потрібна додаткова 
допомога. 

 
 
Записуйте і програвайте процес під час роботи учнів 
Деякі інтерактивні дошки мають інструмент запису, що дозволяє викладачам записувати кроки, які 
вони роблять на інтерактивній дошці, і відтворювати їх для учнів пізніше. Прикладом ефективного 
залучення учнів до самостійної роботи може бути демонстрація викладача для усього класу як 
виконувати завдання. Це може бути будь-який вид діяльності або процес, починаючи від того, як 
вирішити математичне рівняння до того, як відмінювати дієслово. За допомогою функції запису, 
викладач записує свою демонстрацію і відтворює її для учнів, коли вони повертаються до своїх місць, 
щоб самостійно виконати завдання. Записаний процес надає достатньо підказок, щоб допомогти 
більшості учнів виконати свою роботу, що дає можливість викладачу працювати з певними учнями 
сам-на-сам. 
 
Спробуйте “зарядку для розуму” 
Цікаві завдання на початку уроку є чудовим способом зацікавити учнів будь-якого віку у темі, яку вони 
зараз вивчатимуть за допомогою або без інтерактивної дошки. Гарна ―розминка для мозку‖ - це цікаве 
завдання, що змушує мізки учнів працювати і вводить їх у тему, яку вони вивчатимуть. На інтерактивній 
дошці таке завдання може бути грою на основі змісту або ребус, відеокліп з вимкнутим звуком, щоб 
учні  могли написати свій власний діалог, або дослідження місця, яке вивчається, за допомогою карт 
Google Earth. Можливості обмежуються лише вашою уявою.  
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Заохочуйте подальше зацікавлення 
Заохочення подальшого зацікавлення використовує природну цікавість учнів і заохочує незалежне 
навчання протягом усього життя. Додаткова гнучкість уроків на інтерактивній дошці дозволяє 
викладачам давати такий матеріал, який цікавить учнів. Цей розділ розповідає про деякі ідеї для 
розробки уроку на інтерактивній дошці, що заохочує подальше зацікавлення учня. 

 
Створіть спонтанний урок 
Продемонструйте процес дослідження предмету: планування, пошук і збір інформації на тему уроку 
перед вашими учнями. Інтерактивна дошка надає чудову можливість викладачам використовувати 
контент, який цікавить їхніх учнів. Замість того, щоб відкинути питання учня або коментар, що не зовсім 
по темі, яку ви пояснюєте, покажіть учням, як вони можуть знайти більше про тему, дослідивши її 
разом. 

 
Додайте чисту сторінку до вашого уроку на інтерактивній дошці і напишіть або позначте те, що клас 
вже знає про цю спонтанну тему для дослідження. Використовуйте цифрові ресурси, які ви вже зібрали 
і додали до оригінального уроку або пошукайте нові в Інтернеті. Скористайтеся можливістю вказати 
учням на критерії, за якими ви розцінюєте чи є ресурс гарним. Зберіть ресурси шляхом вирізання і 
вставляння зображень і тексту, розташовуючи їх у текстовий редактор, наприклад, у програмі Microsoft 
Word, або ж прямо у пустій сторінці вашого оригінального уроку. Виділіть цікаву інформацію, щоб 
показати учням, як відсортувати інформацію, що стосується теми, від тієї, що не стосується. 
Перетягніть ваш текст або зображення, щоб показати, як розташувати ваші ідеї у логічному порядку. 

 
Викладачі, яким комфортно і цікаво досліджувати дотичні до теми питання, передадуть свій ентузіазм 
до навчання своїм учням. 

 
Залучіть поточні події 
Викладання на інтерактивній дошці дозволяє використовувати найбільш сучасний матеріал, щоб 
показати учням, що те що вони вивчають має застосування поза межами підручника. Підпишіться на 
он-лайн розсилку новин або цифрові журнали на теми, дотичні до вашої викладацької спеціалізації. 
Додайте посилання або включіть ці джерела у ваші уроки на інтерактивній дошці для автентичного 
навчання, з яким ваш підручник не зможе змагатися. 
 

Зберігайте додатковий контент 
Коли викладачі планують і створюють урок, вони часто шукають і переглядають більше контенту, ніж 
буде використано в уроці. Використання навчального програмного забезпечення інтерактивної дошки 
для збереження додаткової інформації або матеріалів джерел дозволить викладачам легко дістати 
додаткову інформацію у відповідь на питання учнів або їхнє зацікавлення. Зазвичай додатковий 
контент можна зберігати як додатки, панелі для перетягування (pull tabs) або як веб-посилання 
всередині уроку. 
 

Ви не знаєте щось насправді, поки не почали цьому вчити 
Як варіант цифрової учнівської презентації, учні можуть створювати власні уроки, щоб 
продемонструвати тему дослідження і поділитися її розумінням з класом. Такий підхід особливо добре 
підходить для проектів, у яких учні або групи учнів відповідають за дослідження частини теми, а потім 
діляться тим, що вони вивчили з іншими, для розуміння цілої теми всім класом Такий підхід є 
популярним способом диференціювати лекції, оскільки це дозволяє учням досліджувати і 
демонструвати розуміння теми по-своєму і через призму власних інтересів. Інтерактивна дошка 
дозволяє учням створювати і виконувати свої власні завдання та вирішувати щодо найбільш 
ефективних і цікавих способів поділитися знаннями з товаришами. 
 
 
 
 
 



 132 

Зробіть можливим оцінювання досягнення цілей навчання 
Використання інтерактивної дошки у класі може здатися дещо складним для викладачів, які звикли 
будувати свій урок навколо створення матеріалів для оцінювання, на кшталт робочого зошиту. Якщо 
весь клас витрачає свій час на роботу з інтерактивною дошкою, а фізичних продуктів для демонстрації 
їхніх знань немає, як викладачі можуть оцінити досягнення учнів? Цей розділ пропонує деякі поради, 
щоб допомогти викладачам почуватися впевнено щодо їхньої можливості для оцінювання досягнень 
учнів, які навчаються за допомогою інтерактивної дошки. 

 
Визначте цілі навчання 
Чітко зазначте, чого ви очкуєте від вашого уроку стосовно навчальних цілей. Гарним методом є 
включати опис навчальної мети у ваш урок у титульній секції вашого уроку для інтерактивної дошки. 
Включення також інформації у ваш урок допомагає зосередити вашу увагу на цих ідеях під час 
створення змісту вашого уроку. Це також надає важливу базову інформацію для викладачів на заміні 
або інших викладачів, з якими ви бажаєте поділитися своїм уроком. 
 

Дослідіть переваги оцінювання, які пропонують інтерактивні системи реакції 
Особисті інтерактивні системи реакції — це інструменти, які надають деякі провайдери як додатковий 
продукт для інтерактивної дошки. Викладачі, які використовують такі системи, можуть включати тести і 
опитування у свої уроки на інтерактивній дошці і надавати персональні кнопки в руки кожному учню, 
щоб вони могли відповідати на ці питання. Відповіді, які кожний учень вводить, можна за бажанням 
записати для перегляду пізніше і викладацьких нотаток. 

 
Використання інтерактивної системи реакції з 
інтерактивною дошкою надає викладачам 
надзвичайні переваги у початковому і 
підсумковому оцінюванні. Інтеграція 
механізму реакції у ваші уроки надає 
можливість одразу отримувати уявлення про 
те, на якому рівні перебуває клас відповідно 
до навчальних цілей, і виявляти тих учнів, 
яким потрібна додаткова допомога або таких, 
кому занадто легко. 

 
інтерактивні системи реакції також можна 
використовувати замість звичайних 
екзаменів — як підсумкове оцінювання, що 
може продукувати оцінки для доповіді, - з 
перевагою миттєвого електронного 

оцінювання, яке можна експортувати як звичайну таблицю для офіційних записів. Результатами 
використання  інтерактивних систем реакції з інтерактивною дошкою є цікаві завдання для уроків, які 
залучають увесь клас, а також миттєве оцінювання і збирання даних по кожному учню.  Інтерактивні 
системи реакції та їхнє використання у класі детально розглядається у наступних розділах. 
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Традиційні інструменти для оцінювання також працюють 
Якщо ви не маєте персональної інтерактивної системи реакції, традиційні методи оцінювання 
досягнень учнями навчальних цілей також працюють у викладанні на інтерактивній дошці. Рубрики і 
ведення записів добре підходять для оцінювання завдань для усього класу, незалежно від того, чи 
вони виконуються на інтерактивній дошці або більш традиційним способом. Можливо, вам буде 
простіше проводити такі типи оцінювання під час викладання на інтерактивній дошці, оскільки учні 
можуть виконувати завдання на дошці, звільняючи вас від ролі помічника і спостерігача. 
 
Як зазначалося у параграфі Залучіть учнів до інших видів роботи у цьому розділі, метою 
інтерактивної дошки є не їхнє використання цілий день, для всього, а тоді і таким чином, щоб це 
приносило користь. Дуже ефективним способом використання інтерактивної дошки є використовувати 
її в основному як інструмент надання інформації для усього класу перед тим, як перейти до інших 
видів роботи учнів, що включають створення індивідуальних фізичних робіт для подальшого 
оцінювання. Іншими словами, викладачі можуть будувати час у класі і оцінювання так, як вони робили 
б це без інтерактивної дошки, але при цьому користуватися багатьма перевагами для викладання за 
допомогою інтерактивної дошки.  
 

Створення контенту для спільного користування 
Можливість для учнів створювати і ділитися контентом на інтерактивній дошці залучає засвоєння 
матеріалу за допомогою дослідження, кураторський стиль викладання і дозволяє індивідуальну 
демонстрацію розуміння. Це також звільняє викладача для проведення більш детального оцінювання 
за рубриками поки учні роблять презентацію контенту і проводять маніпуляції на інтерактивній дошці. 
 

Учнівські портфоліо 
Програмне забезпечення інтерактивної дошки може стати корисним інструментом для завдань і 
збирання незалежних учнівських робіт. Викладачі можуть почати з презентації завдання уроку для 
всього класу на інтерактивній дошці, а потім попросити учнів виконати самостійну або групову роботу 
вдома або на шкільних комп'ютерах. Таку самостійну роботу можна проводити за допомогою 
програмного забезпечення інтерактивної дошки, якщо його можна встановити на шкільних комп'ютерах 
або на персональних комп'ютерах учнів. Робота з цим програмним забезпеченням гарантує, що 
формат завдання буде знайомим і схожим на той, який було продемонстровано для усього класу. 
Оскільки робота є цифровою, індивідуальну або групову роботу можна легко зберігати, сортувати і 
складати у учнівські портфоліо для оцінювання і демонстрації батькам. 
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Зробіть можливим огляд і повторення 
 
Огляд і повторення дозволяє учням бачити і пишатися прогресом свого навчання і підкреслює ідею, що 
робота, яку учні виконують у класі, потрібна і важлива. Регулярне повторення матеріалу допомагає 
освіжити інформацію і згадати її під час тесту і допомагає у довготерміновому засвоєнні. У цьому 
розділі описано кілька ідей щодо того, як скористатися унікальними можливостями для повторення, які 
пропонує викладання за допомогою інтерактивної дошки. 
 

Зробіть доступними матеріали для повторення 
Цифровий контент уроку дозволяє викладачам надавати доступ до матеріалів уроків і приміток до них  
для учнів  з дому, за допомогою розміщення їх на учбовому веб-сайті. Учні можуть переглядати 
матеріали до уроків під час роботи над своїми домашніми завданнями або простіше повторювати 
матеріал перед контрольними роботами. Це також надає можливість батькам оцінити матеріал, щоб 
вони могли обговорити  і закріпити цей матеріал зі своїми дітьми. 
 

Скористайтеся підвищеною гнучкістю уроку 
Якщо учням важко дається тема поточного уроку, за допомогою інтерактивної дошки можна легко 
дістати минулий файл для швидкого повторення або витратити більше часу на засвоєння базового 
матеріалу. 
 

Зробіть щоденні або щотижневі огляди частиною вашого навчального процесу 
Однією з переваг інтерактивних дошок є те, що якщо ви регулярно використовуєте інтерактивну дошку 
для презентації тем або проведення уроків, увесь ваш контент залишається доступним за допомогою 
кількох дотиків пальців. Зробіть частиною вашого звичайного процесу відкривати уроки, які ви вивчали 
протягом тижня, і повторювати або обговорювати найбільш важливі моменти файлу в класі. Складіть 
сторінки з кількох уроків у файл для нового тижневого огляду, запитуючи учнів, що на їхню думку було 
найважливішим або найголовнішим. В кінці розділу візьміть ці тижневі файли для огляду і в рамках 
роботи з усім класом утворіть новий файл огляду розділу, впорядкувавши найбільш важливі концепції. 
Доступ до минулих уроків і їхній огляд допомагає засвоєнню матеріалу і дозволяє учням отримувати 
ширшу картину контенту, якій вони могли вважати не важливим  без контексту подальшого навчання. 
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Додаткові Ресурси 
 
 

Що далі?  
 
Компанія SMART надає Вам підтримку при використанні продуктів SMART, використовуючи різні 
ресурси, включаючи надання безкоштовних навчальних матеріалів, які є доступними на веб-сайті 
компанії SMART, а також  пропонує послуги спеціального онлайн-центру ресурсів для викладачів. 
 
 
 
 
 



 136 

Навчальний центр SMART 
Навчальний центр компанії SMART – це те місце, де Ви знайдете додаткові навчальні ресурси та 
підтримку, включаючи безкоштовні навчальні матеріали та сеансу з тренінгу в режимі он-лайн, які 
допоможуть Вам ефективно використовувати продукти компанії SMART. Завітайте на сайт: 
http://www.smarttech.com/traningcenter. 
 

Безкоштовні навчальні матеріали 
Безкоштовні навчальні матеріали, доступні на сайті навчального центра SMART,  допоможуть Вам 
набути практичного досвіду у використанні продуктів компанії SMART, а також розвинути навики 
проведення занять з використанням інтерактивної електронної дошки SMART Board. 
Стислі довідкові керівництва користувача -  це прості одно- чи двосторінкові огляди програмного 
забезпечення SMART Notebook, а також інших продуктів компанії SMART. Вони спеціально 
відформатовані для зручного друкування,  і, таким чином, Ви зможете зберігати їх поруч з Вашим 
комп’ютером або поруч з інтерактивною електронною дошкою SMART Board на той випадок, якщо Вам 
потрібно буде згадати, яким чином використовувати деякі з функцій.  
 

Безкоштовні тренінги в режимі онлайн 
Тренувальні сесії від компанії SMART тривають в режимі онлайн впродовж 30-45  хвилин у формі 
комп'ютерних і телефонних конференцій, які забезпечують швидкий і безкоштовний огляд основ 
використання продуктів компанії SMART. Кожен сеанс проводиться за участю інструктора компанії 
SMART, який користується продуктами компанії на повсякденній основі. Сеанси тренінгів компанії 
SMART в режимі онлайн є корисними з точки зору повторення пройденого матеріалу, і вони також 
надають Вам можливість поставити запитання. 
 
Компанія SMART надає онлайн сесії зокрема на такі теми:  
• Основи роботи з інтерактивною дошкою SMART Board  
• Основи роботи з програмним забезпеченням SMART Notebook  
• Інтерактивна система реакції Senteo 
• Налаштування вашої інтерактивної дошки SMART Board 
• Програмне забезпечення з управління класом SynchronEyes 
 
Для отримання повного переліку безкоштовних онлайн сеансів з тренінгу завітайте на сайт: 
http://www.smarttech.com/trainingcenter/online/index.asp. 
 
Ми постійно працюємо над створенням нових пропозицій з проведення безкоштовних тренінгів в 
режимі онлайн. Заходьте на веб-сайт SMART Training Search якомога частіше для своєчасного 
отримання інформації про проведення сеансів тренінгів. 
 
 
 

http://www.smarttech.com/traningcenter
http://www.smarttech.com/trainingcenter/online/index.asp
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Підтримка компанії SMART 
Веб-сайт компанії SMART з питань технічної підтримки пропонує різноманітні варіанти підтримки для 
користувачів продуктів. Завітайте на веб-сайт SMART з питань технічної підтримки, щоб завантажити 
програмне забезпечення, зокрема програмне забезпечення SMART Notebook, Senteo та SynchronEyes. 
Ви також знайдете тут необхідні інструкції з інсталяції та керівництва користувачів, статті, практичні 
поради та рекомендації, вказівки по усуненню несправностей, а також відповіді на всі Ваші запитання. 
Ви також можете скористатися сайтом підтримки для зв'язку зі співробітниками Технічної Підтримки 
компанії SMART, а також для реєстрації придбаних Вами продуктів компанії SMART. 
 
Завітайте на сайт: www.smarttech.com/Support/. 
 

Завантаження програмного забезпечення SMART 
Найновіші версії та оновлення для програмного забезпечення SMART доступні на сайті 

www.smarttech.com у розділі завантаження програмного забезпечення. Ви можете завантажити 
програмне забезпечення SMART Notebook, а також безкоштовно випробувати та оцінити переваги 
інших корисних програм на сайті: http://www2.smarttech.com/st/en-US/Support/Downloads/default.htm. 
 

Веб-сайт SMART з навчальними рішеннями 
Веб-сайт SMART з навчальними рішеннями — це онлайн-спільнота, де викладачі можуть ділитися 
ресурсами і ідеями з іншими викладачами у всьому світі. Веб-сайт з навчальними рішеннями — це 
місце, де ви знайдете наступні ресурси: 
 

 Безкоштовні навчальні ресурси для використання з продуктами SMART, включаючи колекції 
контенту, програми та веб-сайти 

 Сотні завдань для уроків у програмному забезпеченні SMART Notebook, створені відповідно до 
державних і регіональних стандартів навчального плану 

 Програми професійного розвитку для нагородження, визнання та підтримки викладачів 

 Дослідження ефективності інтерактивної дошки SMART Board у навчанні 

 Поради для викладачів щодо використання продуктів SMART, інтеграції периферії, вивчення 
технологій вдалого написання та оцінки 
 
 
 
 
 
 

http://www.smarttech.com/Support/
http://www.smarttech.com/
http://www2.smarttech.com/st/en-US/Support/Downloads/default.htm
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Інколи найважчою частиною створення завдання для уроку є придумати креативні ідеї. Ви можете 
пошукати натхнення на веб-сайті навчальних рішень SMART, в онлайн-спільноті, де викладачі можуть 
ділитися своїми ресурсами і ідеями з іншими викладачами з усього світу. 
 
Завітайте на www.education-smarttech.com і оберіть Educator resources > Lesson  activities, що 
проглянути завдання для уроків у програмі SMART Notebook, створені викладачами і організовані 
відповідно до стандартів навчальних планів. 
 

 

SMART Learning Marketplace 
SMART Learning Marketplace — це сервіс контенту за підпискою, що підтримується Cambridge 
University Press та Global Grid for Learning. Marketplace містить понад мільйон зображень, відеокліпів, 
об'єктів для маніпуляцій та аудіофайлів, які ви можете швидко знаходити і вставляти у ваші завдання 
для уроків. 
 
Пропонуючи лише високоякісний контент від провідних освітніх видавництв, музеїв та викладачів 
тенологій і програмного забезпечення, Learning Marketplace гарантує, що ви знайдете необхідні вам 
ресурси, коли потрібно.  
 
Як повністю інтегрована функція в програмному забезпеченні SMART Notebook, ви можете шукати у 
Marketplace прямо у вашому файлі SMART Notebook, щоб знайти ресурси з дозволеними авторськими 
правами для будь-якого предмету і рівня. 
 
Завітайте на www.smarttech.com/learningmarketplace.  
 

Веб-сайт SMART з обміну інформацією 
Вам також може стати у нагоді SMART Exchange. Веб-сайт SMART з обміну інформацією 
www.exhcnage-smarttech.com – це безкоштовний ресурс,  який забезпечує Вас розмаїттям ресурсів для 
навчання за допомогою технологій. Обмінюйтесь ідеями та знаходьте інформацію, яку шукаєте, 
включаючи останні дослідження, найкращі практики, історії успіху та щоденні інструменти.  

 
 

http://www.education-smarttech.com/
http://www.smarttech.com/learningmarketplace
http://www.exhcnage-smarttech.com/
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SMART's Teachers' Hub 
SMART's Teachers' Hub має усі ресурси, які вам потрібні для початку. 
 
Завітайте на www.edication.smarttech.com/Hub.  

 
Акредитовані титули SMART 
Знайдіть безліч мультимедійного контенту і програмного забезпечення для покращення роботи в класі 
на веб-сайті навчальних рішень SMART. SMART акредитує навчальні титули на основі їхнього рівня 
взаємодії з інтерактивними дошками SMART Board та програмним забезпеченням SMART Notebook.  
 
SMART пропонує наступні рівні акредитації. 
 

Ready Це базовий рівень акредитації для програмного забезпечення або продукту 
контенту, що означає, що SMART схвалив титул для використання з його продуктами. 
 
 
 

 
Enabled Продукти на цьому рівні відповідають вимогами рівня Ready і також інтегровані у 
інструменти SMART Board. Інтеграція збільшує інтерактивність, оскільки користується 
перевагами функції цифрових чорнил SMART Ink Aware. 
 
 
 
Select Програмне забезпечення і контент-продукти цього рівня відповідають усім вимогам 
рівня Enabled і спеціально розроблені для використання з програмним забезпеченням 
SMART Notebook. 
 
 

 
Отримати доступ до списку акредитованого програмного забезпечення і деталі щодо цих програм 
можна на веб-сайті навчальних рішень SMART, обравши Educator Resources > SMART accredited 
software. Акредитоване програмне забезпечення розподіляється за такими категоріями як предмет та 
рівень, що надає можливість швидко знаходити програмне забезпечення, що відповідає вашим 
потребам. 
  

 

http://www.edication.smarttech.com/Hub

